Fast Track to DIGITAL IMAGING

Basic Image Manipulation

Advanced Image Manipulation

Compositing

Painting And Illustrating

Networking Resources

Tutorials on The Web

Galleries On The Web

YOUR HANDY GUIDE TO EVERYDAY TECHNOLOGY
Fast Track
to
Digital Imaging

By Team Digit
Credits

The People Behind This Book

EDITORIAL
Robert Sovereign-Smith Assistant Editor
Devarajan Mahadevan Associate Editor
Nash David Writer, Copy Editor
Nimish Chandiramani Writer, Copy Editor
R Srikanth Writer
Kartik Menon Writer

DESIGN AND LAYOUT
Vijay Padaya Layout Designer
Sivalal S Cover Design
Harsho Mohan Chattoraj Illustrator

© 9.9 Interactive Pvt. Ltd.
Published by 9.9 Interactive
No part of this book may be reproduced, stored in a retrieval system or transmitted in any form or by any means without the prior written permission of the publisher.

April 2008
Free with Digit. Not to be sold separately. If you have paid separately for this book, please e-mail the editor at editor@thinkdigit.com along with details of location of purchase, for appropriate action.
A True Introduction

The world of digital imaging can be a daunting place for the beginner—especially when you go online and take a look at what people can accomplish with tools that at first glance seem so...well, worthless. We can’t teach you creativity, but if you’ve got some, and you’re looking to get started with digital imaging, welcome.

It’ll be obvious from the following pages that this Fast Track is for beginners. Summer vacations will soon be upon us (well, you—we work all year round), and we’ve got to get something to occupy those idle hands, don’t we?

So here we are, starting with the very basics. In the first chapter, we’ll go through many of the terms you’re going to encounter in this area, and how to apply basic edits to your photos (or artwork, as the case may be).

Once you’ve cut your teeth on that, we’ll take a trip through more advanced image editing techniques—right from working with Camera Raw images, to changing colour tones to turning a perfectly innocent image into a psychedelic monstrosity. Then come the layers....

Image compositing is a highly underestimated art. It seems like the simple act of slapping one image on to the other, but it’s so much more. All those hoaxes you’ve seen on the Internet—the ghost in the digital photo, the ultra-creepy mermaid skeleton, the...ahem...fake nudes—all made through the magic of compositing. We’re not going to teach you how to create your own fake pornography, but by the end of this chapter, you might be skilled enough to do so anyway.

Another facet of the imaging realm is the vector illustration. It can be difficult to fathom, but if you’re ever planning to work with the print media or even Flash-based projects, understanding vector graphics is a crucial skill to have.

And finally, when you grow beyond the scope of this Fast Track (as you inevitably must), you can take to the Web to refine your skills, and show your work to the world!
CONTENTS

Chapter 1  Basic Image Manipulation  7
  1.1  Image formats  8
  1.2  Transferring images to the PC  11
  1.3  Cropping, Resizing And Rotating Images  19
  1.4  Colour Modes  22
  1.5  Hue, Saturation and Brightness  26
  1.6  Red-eye Removal  28
  1.7  Noise removal  30
  1.8  Image Effects  31
  1.9  Printers  38
  1.10  Online Image-editing Tools  41

Chapter 2  Advanced Image Manipulation  45
  2.1  Camera Raw  46
  2.2  Advanced Image Editing  55

Chapter 3  Compositing  59
  3.1  The Concept Of Layers  60
  3.2  Alpha Channels And Layer Masks  61
  3.3  Layer Blending Modes  62
  3.4  Creating Collages  65
  3.5  Stitching Images Together  67

Chapter 4  Vector Graphics  71
  4.1  Graphics Tablets  72
  4.2  Vector Graphics Essentials  77
  4.3  Corners And Points In Vector Graphics  84
  4.4  Creating and editing vector graphics  86
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Knowledge Websites</th>
<th>91</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1</td>
<td>Introduction</td>
<td>92</td>
</tr>
<tr>
<td>5.2</td>
<td>Knowledge Web sites</td>
<td>93</td>
</tr>
<tr>
<td>5.3</td>
<td>Conclusion</td>
<td>106</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Tutorial Websites</th>
<th>107</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>Introduction</td>
<td>108</td>
</tr>
<tr>
<td>6.2</td>
<td>Tutorials</td>
<td>109</td>
</tr>
<tr>
<td>6.3</td>
<td>Contest Sites</td>
<td>118</td>
</tr>
<tr>
<td>6.4</td>
<td>Downloadable Resource Websites</td>
<td>124</td>
</tr>
<tr>
<td>6.5</td>
<td>Conclusion</td>
<td>126</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Showcase Websites</th>
<th>127</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1</td>
<td>Introduction</td>
<td>128</td>
</tr>
<tr>
<td>7.2</td>
<td>The Galleries</td>
<td>128</td>
</tr>
<tr>
<td>7.3</td>
<td>Conclusion</td>
<td>142</td>
</tr>
</tbody>
</table>

| Notes   |                   | 143 |
Welcome to the world of image editing. Consider you have captured some images with your digicam and their contrast isn’t too appealing. This chapter gives you the basics of image-editing, so that you can sharpen those photography skills to take better, more vivid pictures.
1.1 Image formats

Let's start with the very basics—image formats. There are several image formats available for storing all those great photos you take. This section examines them in brief.

1.1.1. BMP

BMP or bitmap is a raster format, which is used practically for all possible raster data storage. It is device independent, that is, it determines the pixel's colour without reference to the display device and enables you to record images with varying quality levels (to the point of 32 bits).

The main advantage of this format is its usability and wide software support. The compression algorithm used in BMP, can be one of the RLE run-length encoding variants. However, most files do not use compression.

1.1.2. JPEG

This format was designed to transfer graphic data and images over digital networks and was generally used to hold and transfer full colour photorealistic images. Before JPEG, there were very few formats, which supported 24-bit halftone images. TIFF and BMP formats allowed holding 24-bit data, but they failed to perform lossless compression of the data, which contained 1000 colours from the real world, on the high quality level.

JPEG compresses photos, though with quality loss. Photos and multi-colour images, transferred in this format, are ideal for networking. It is not possible to refine JPEG images, though it is possible to debase them by decreasing the file size. This format is primarily used to hold photorealistic graphic images with a large number of colours. Compressed data capacity depends on image contents.

JPEG supports Progressive JPEG standard, which conceptually looks like interlaced in the GIF format. This means that the JPEG
Progressive format images are loaded by parts, which are displayed, as they are loaded. Such a format is good for large files.

1.1.3. GIF
The GIF file format is used to hold and transfer images in the index colour mode. This format also supports a lossless LZW compression algorithm (a single file may contain a set of images) and interlaced mode. It supports an additional channel to perform a transparency effect, and to hold a set of images that form the frames of an animation.

Files in this format have a set of compression algorithm features that allow compressing images with sequential horizontal colours. This means that a file which contains horizontal bars, will take lesser space than the same file with vertical bars.

GIF, unlike JPEG, uses a lossless compression algorithm. It also uses a patented compression/decompression algorithm, which is called LZW (Lempel Zev Welch). The interlaced mode enables it to refine images, while they are loaded. It is very convenient for large files, as you can see the main image features in several seconds after loading.

1.1.4. PCX
PCX format is one of the most usable graphic formats. Originally, it was designed by Zsoft for PC Paintbrush MS-DOS. Hence, it is also known as PC Paintbrush format. Zsoft signed a deal with Microsoft, and as a result, the latter was entitled to use PCX format with other products, including Microsoft Paintbrush for Windows (Microsoft Paintbrush program is delivered with each copy of MS Windows). PCX files are used for graphic data storage and exchange in desktop publishing systems. Image data is encoded with the help of one of the RLE algorithm variants.

1.1.5. TIFF
This format was generally used to hold scanned white and black images. It got prevalence for its support of incompact colour RGB
images. Later revisions made possible to hold palette colour images and support LZW compression algorithm. Still later versions of the TIFF format supported CMYK and YCbCr colour images and JPEG compression algorithm.

Currently, the TIFF format is a rich and flexible file format, supported by many programs. It is capable of recording halftone images with different pixel intensity, and is considered to be a perfect format for graphic data storage and processing. TIFF is one of the most useful and integrated raster formats. It is easily supported among various platforms and used for different purposes (besides the Internet).

1.1.6. PNG
The PNG file format is a comparatively new progressive format originally designed to replace the outdated GIF. The PNG format has got a new set of features that GIF lacks.

PNG also performs lossless compression with the help of a Deflate algorithm and supports the interlaced mode. The fact, that the format performs a lossless compression, makes it possible to hold photorealistic images. Images don’t lose their quality while compressing and decompressing. The PNG format is specially used for networking.

1.1.7. WMF
You can use WMF files to hold vector and halftone images in the working memory or in disks with post output display. Windows Metafile format is a specific Windows format. It is supported by a lot of “non-Windows” applications for data exchange with Windows applications. Out of Microsoft Windows interface prevalence, WMF format is considered to be a general format for graphic applications and is supported across all platforms.
1.2. Transferring images to the PC

Now that we know something about image formats, let’s look at the devices which are used to capture/store these images.

1.2.1. Digital Cameras

A digital camera is a camera that captures still photographs digitally by recording images on a light-sensitive sensor.

Digital cameras include features that are not found in film cameras, such as displaying an image on the camera’s screen immediately after it is recorded, the capacity to take thousands of images on a single small memory device, the ability to record video with sound, the ability to edit images, and deletion of images allowing reuse of the storage device. Digital cameras are incorporated into many devices ranging from PDAs and mobile phones (called camera phones) to vehicles.

The term digital still camera (DSC) usually refers to a live-preview digital camera, with an electronic display, usually a rear-mounted LCD as the principal means of framing and previewing, before taking the photograph and for viewing stored photographs. All use either charge-coupled device (CCD) or a CMOS image sensor to sense the light intensities across the focal plane.

Images may be transferred to a computer, printer or other device in a number of ways—the USB mass storage device class makes the camera appear to the computer as if it were a disk drive, the Picture Transfer Protocol (PTP) and its derivatives may be used, FireWire is sometimes supported, and the storage device may simply be removed from the camera and inserted into another device.

The resolution of a digital camera is often limited by the camera sensor (typically a CCD or CMOS sensor chip) that turns light into discrete signals, replacing the film in traditional photography. The sensor is made up of millions of “buckets” that essentially count the number of photons that strike the sensor. This means that the brighter the image at that point, the larger the value that
is read for that pixel. Depending on the physical structure of the sensor a colour filter array may be used, which requires a de-mosaicing/interpolation algorithm. The number of resulting pixels in the image determines its “pixel count”. For example, a 640x480 image would have 307,200 pixels or approximately 307 kilopixels while a 3872 x 2592 image would have 10,036,224 pixels, or approximately 10 megapixels.

The pixel count alone is commonly presumed to indicate the resolution of a camera, but this is a misconception. There are several other factors that impact a sensor's resolution. Some of these factors include sensor size, lens quality, and the organisation of the pixels.

Many digital cameras have preset modes for different applications. Within the constraints of correct exposure, various parameters can be changed, including exposure, aperture, focussing, light metering, white balance, and equivalent sensitivity. For example a portrait might use a wider aperture to render the background out of focus and would seek out and focus on a human face rather than other image contents.

Common formats for digital camera images are the Joint Photography Experts Group standard (JPEG) and Tagged Image File Format (TIFF).

1.2.2. Scanners
In computing, a scanner is a device that analyzes images, printed text, or handwriting, or an object (such as an ornament) and converts it to a digital image. Most scanners today are variations of the desktop (or flatbed) scanner. The flatbed scanner is the most common in offices. Hand-held scanners, where the device is moved by hand, were briefly popular but are now not used due to the difficulty of obtaining a high-quality image. Both these types of scanners use charge-coupled device (CCD) or Contact Image Sensor (CIS) as the image sensor, whereas older drum scanners use a photomultiplier tube as the image sensor.
Another category is the rotary scanner, used for high-speed document scanning. This is another kind of drum scanner, but it uses a CCD array instead of a photomultiplier. Other types of scanners are planetary scanners, which take photographs of books and documents, and digital camera scanners, which are based on the concept of reprographic cameras. Due to increasing resolution and new features such as anti-shake, digital cameras have become an attractive alternative to regular scanners. While still containing disadvantages compared to traditional scanners, digital cameras offer unmatched advantages in speed and portability.

There are different types of scanners, depending on the user’s purposes. Described below are the most commonly used types that can be found in the market:

Drum scanners capture image information with photomultiplier tubes (PMT), rather than the charge-coupled-device (CCD) arrays found in flatbed scanners and inexpensive film scanners. Reflective and transmissive originals are mounted on an acrylic cylinder, the scanner drum, which rotates at high speed while it passes the object being scanned in front of precision optics that deliver image information to the PMTs. Most modern colour drum scanners use 3 matched PMTs, which read red, blue, and green light respectively. Light from the original artwork is split into separate red, blue, and green beams in the optical bench of the scanner.

The drum scanner gets its name from the large glass drum on which the original artwork is mounted for scanning—they usually take 11x17-inch documents, but the maximum size varies with the manufacturer. One of the unique features of drum scanners is the
ability to independently control the sample area and aperture size. The sample size is the area that the scanner encoder reads to create an individual pixel. The aperture is the actual opening that allows light into the optical bench of the scanner. The ability to control the aperture and sample size separately is particularly useful for smoothing the film grain when scanning black-and-white and colour negative originals.

While drum scanners are capable of scanning both reflective and transmissive artwork, a good-quality flatbed scanner can produce excellent scans from reflective artwork. As a result, drum scanners are rarely used to scan prints, now that high quality inexpensive flatbed scanners are readily available. Film, however, is where drum scanners continue to be the tool of choice for high-end applications. Because film can be wet-mounted to the scanner drum and because of the exceptional sensitivity of the PMTs, drum scanners are capable of capturing very subtle details in film originals.

Currently drum scanners are obsolete and only a few companies continue to manufacture them. While prices of both new and used units have come down over the last decade, they still require considerable monetary investment when compared to CCD flatbed and film scanners. However, drum scanners continue to stay in demand due to their capacity to produce scans that are superior in resolution, colour gradation, and value structure. Also, since drum scanners are capable of resolutions up to 12,000 ppi, their use is generally recommended when a scanned image is going to be enlarged.

In most current graphic-arts operations, high quality flatbed scanners have replaced drum scanners, being both less expensive as well as faster. However, drum scanners continue to be used in high-end applications, such as museum-quality archiving of photographs and print production of high-quality books and magazine advertisements. In addition, due to the greater availability of pre-owned units many fine-art photographers are acquiring drum scanners, creating a new niche market for these machines.
A flatbed scanner is usually composed of a glass pane (or platen), under which there is a bright light (often xenon or cold cathode fluorescent lamp) which illuminates the pane, and a moving optical array, whether CCD or CIS. Colour scanners typically contain three rows (arrays) of sensors with red, green and blue filters. Images to be scanned are placed face down on the glass, an opaque cover is lowered over it to exclude ambient light, and the sensor array and light source move across the pane, reading the entire area. An image is therefore visible to the charge-coupled device only because of the light it reflects. Transparent images do not work in this way, and require special accessories that illuminate them from the upper side. Many scanners offer this as an option.

Hand scanners are manual devices that are dragged across the surface of the image to be scanned. Scanning documents in this manner requires a steady hand, as an uneven scanning rate would produce distorted images—a little light on the scanner would indicate if the motion was too fast. They typically have a “start” button, which is held by the user for the duration of the scan; some switches to set the optical resolution; and a roller, which generates a clock pulse for synchronisation with the computer. Most hand scanners were monochrome, and produced light from an array of green LEDs to illuminate the image. A typical hand scanner also had a small window through which the document being scanned could be viewed.

Scanners typically read red-green-blue colour (RGB) data from the array. This data is then processed with some proprietary algorithm to correct for different exposure conditions and sent to the computer via the device’s input/output interface (usually SCSI or LPT in machines prior to the USB standard). Colour depth varies depending on the scanning array characteristics, but is usually at least 24 bits. High quality models have 48 bits or more colour depth. The other qualifying parameter for a scanner is its resolution measured in pixels per inch (ppi), more accurately referred to as samples per inch (spi). Instead of using the scanner’s true optical resolution, manufacturers refer to the
interpolated resolution, which is much higher thanks to software interpolation.

The higher the resolution, the larger is the file. In most cases, there is a trade-off between manageable file size and level of detail.

The third important parameter for a scanner is its density range. A high density range means that the scanner is able to reproduce shadow details and brightness details in one scan.

There are four common means of transferring images from scanners:

- Parallel connection through a parallel port is the slowest common transfer method. Early scanners had parallel port connections that could not transfer data faster than 70 Kbps. The primary advantage of the parallel port connection was economy—it avoided adding an interface card to the computer.

- Small Computer System Interface (SCSI), which is supported only via an additional SCSI interface card. Some SCSI scanners are supplied together with a dedicated SCSI card for a PC, although any SCSI controller can be used. During the evolution of the SCSI standard, speeds increased with backwards compatibility; a SCSI connection can transfer data at the highest speed which both the controller and the device support. SCSI has been largely replaced by USB and FireWire, either of which are directly supported by most computers, and which are easier to set up than SCSI.

- USB scanners can transfer data quickly, and are easier to use, yet cheaper than SCSI devices. The early USB 1.1 standard could transfer data at only 1.5 Mbps (slower than SCSI), but the later USB 2.0 standard can theoretically transfer up to 60 MBps (although practical rates are much lower), resulting in faster operation.

- FireWire is an interface that is much faster than USB 1.1 and comparable to USB 2.0. FireWire speeds are 25, 50 and 100 MBps
There's also a newer 400 MBps version.

In order to simplify applications programming, some Applications Programming Interfaces (API) were developed. The API presents a uniform interface to the scanner. This means that the application does not need to know the specific details of the scanner in order to access it directly. For example, Adobe Photoshop supports the TWAIN standard. Consequently, (in an ideal world) Photoshop can acquire an image from any scanner that also supports TWAIN.

In practice, there are often problems with an application communicating with a scanner. Either the application or the scanner manufacturer (or both) may have faults in their implementation of the API.

In addition to the API, many scanners come bundled with other software such as a scanning utility, some type of image-editing application such as Photoshop and OCR software. OCR, or optical character recognition, enables the conversion of graphical images of text into standard text that can be edited using common word-processing and text-editing software. OCR utilises an averaging algorithm to determine the character shape, then matches that shape to a corresponding letter or number.

The scanned result is a non-compressed RGB image, which can be transferred to a computer's memory. Some scanners compress and clean up the image using embedded firmware. Once on the computer, the image can be processed with a raster graphics program, such as Photoshop, and saved on a storage device (such as a hard disk).

In common use, scanned pictures are stored on a computer's hard disk, normally in image formats such as JPEG, TIFF, Bitmap, and PNG. Some scanners can also be used to capture editable text, so long as the text can be read by the computer in a discernable font. This process is called Optical Character Recognition (OCR).
1.2.3. Portable Multimedia Players

A portable multimedia player (PMP) is a consumer electronics device that is capable of storing and playing digital media. In PMPs, the data is typically stored on a hard drive, micro-drive or flash memory.

PMPs are capable of storing images, and even playing digital audio and video. Usually, a colour LCD or OLED screen is used as a display. Various players include the ability to record video, usually with the aid of optional accessories or cables, and audio, with an inbuilt microphone or from a line-out cable or FM tuner. Some players include readers for memory cards, which are advertised to equip players with extra storage or transferring media.

Image files are usually viewed on the JPEG format and some players, like the iPod series provide compatibility to additional file formats like GIF, PNG and TIFF.

More and more devices are now equipped with a touch screen as the primary or alternate input. This can be for convenience and/or aesthetic purposes.
1.3. Cropping, Resizing And Rotating Images

Now that we have seen the various image formats and input devices, let’s do some very basic photo-editing. This chapter is about the use of Adobe Photoshop as an editing tool, unless stated otherwise.

1.3.1. Cropping

Cropping is the process of removing portions of an image to create focus or strengthen the composition. In Photoshop, you can crop an image using the crop tool and the Crop command. You can also trim pixels using the Trim command. The crop tool provides the most options for cropping images.

To crop an image:
1. Select the crop tool.
2. Set the mode of the crop tool:
   a) To crop the image without resampling (default), make sure that all the text boxes in the options bar are empty. You can click the Clear button to quickly clear all text boxes.
   b) To resample the image during cropping, enter a height, width and/or resolution in the options bar. Resampling during cropping combines the function of the Image > Image Size command with that of the crop tool.
3. Define the cropping marquee by dragging over the part of the image you want to keep. The marquee doesn’t have to be precise—you can adjust it later.

Note
In Photoshop, the Hide option is not available for images that contain only a background layer. If you want to crop a background by hiding, convert the background to a regular layer first. Specify whether you want to use a cropping shield to shade the area of the image that will be deleted or hidden. When Shield is selected, you can specify a colour and opacity for the cropping shield. When Shield is deselected, the area outside the cropping marquee is revealed.

Note
In Photoshop, you can’t rotate the marquee for an image in the Bitmap mode.
4. Do the following in the options bar:

- Specify whether you want to hide or delete the cropped area. Select **Hide** to preserve the cropped area in the image file. You can make the hidden area visible by moving the image with the move tool. Select **Delete** to discard the cropped area.

5. If necessary, adjust the cropping marquee:

- To move the marquee to another position, place the pointer inside the bounding box and drag.

- To scale the marquee, drag a handle. To constrain the proportions, hold down Shift as you drag the corner handle.

- To rotate the marquee, position the pointer outside the bounding box (the pointer turns into a curved arrow), and drag it. To move the central point around which the marquee rotates, drag the circle at the centre of the bounding box.

6. Do one of the following:

- Press **Enter**. Click the **Commit** button in the options bar, or double-click inside the cropping marquee.

- To cancel the cropping operation, press **Esc** or click the **Cancel** button in the options bar.

To crop an image using the Crop command:
1. Select the part of the image you want to keep.
2. Choose **Image > Crop**.

To crop an image using the Trim command:
1. Choose **Image > Trim**.
2. In the Trim dialog box, select an option:

- **Transparent Pixels** to trim away transparency at the edges of the image, leaving the smallest image containing non-transparent pixels.

- **Top Left Pixel Colour** to remove an area the colour of the upper left pixel from the image.
DIGITAL IMAGING

❍ Bottom Right Pixel Colour to remove an area the colour of the lower right pixel from the image.

3. Select one or more areas of the image to trim away: Top, Bottom, Left, or Right.

1.3.2. Resizing
Resizing is the process of altering the height, width or aspect ratio of the image.

The Canvas Size command lets you add or remove work space around an existing image. You can crop an image by decreasing the canvas area. Added canvas appears in the same colour or transparency as the background.

To use the Canvas Size command:
1. Choose Image > Canvas Size.
2. In Photoshop, choose the units of measurement you want.
3. The Columns option measures the width in terms of the columns specified in the Rulers & Units preferences.
4. Do one of the following:
   ❍ Enter the dimensions of the canvas in the Width and Height boxes.
   ❍ Select Relative, and enter the amount of variation in the size of the canvas. (Enter a negative number to decrease the size of the canvas.)
5. To Anchor, click a square to indicate where to position the existing image on the new canvas.
6. Click OK.

1.3.3. Rotating
The Rotate Canvas command lets you rotate or flip an entire image. The commands do not work on individual layers or parts of layers, paths or selection borders.
To rotate or flip an entire image:
Choose Image > Rotate Canvas, and choose one of the following commands from the submenu:
- 180° to rotate the image by a half-turn.
- 90° CW to rotate the image clockwise by a quarter-turn.
- 90° CCW to rotate the image counter clockwise by a quarter-turn.
- Arbitrary to rotate the image by the angle you specify. If you choose this option, enter an angle between -359.99 and 359.99 in the angle text box, and then select CW or CCW to rotate clockwise or counter clockwise. Click OK.
- Flip Canvas Horizontal (Photoshop) to flip the image horizontally, along the vertical axis.
- Flip Canvas Vertical (Photoshop) to flip the image vertically, along the horizontal axis.

1.4. Colour Modes

Colour modes are used in image editors to specify the basic set of colour combinations that an image would have. Photoshop supports the following colour modes:

1.4.1. RGB
Photoshop’s RGB Colour mode uses the RGB model, assigning an intensity value to each pixel ranging from 0 (black) to 255 (white) for each of the RGB (red, green, blue) components in a colour image. For example, a bright red colour might have an R value of 246, a G value of 20, and a B value of 50. When the values of all three components are equal, the result is a shade of neutral grey. When the values of all components are 255, the result is pure white; when the values are 0, the result is pure black.
RGB images use three colours, or channels, to reproduce colours on the screen. The three channels translate to 24 (8 bits x 3 channels) bits of colour information per pixel. With 24-bit images, up to 16.7 million colours can be reproduced. With 48-bit images (16 bits per channel), even more colours can be reproduced. In addition to being the default mode for new Photoshop images, the RGB model is used by computer monitors to display colours. This means that when working in colour modes other than RGB, such as CMYK, Photoshop interpolates the CMYK image to RGB for display on-screen.

Although RGB is a standard colour model, the exact range of colours represented can vary, depending on the application or display device. Photoshop’s RGB Colour mode varies according to the working space setting that you have specified in the Colour Settings dialog box.

1.4.2 CMYK Colour Mode

In Photoshop’s CMYK mode, each pixel is assigned a percentage value for each of the process inks. The lightest (highlight) colours are assigned small percentages of process ink colours, the darker (shadow) colours higher percentages. For example, a bright red might contain 2% cyan, 93% magenta, 90% yellow, and 0% black. In CMYK images, pure white is generated when all four components have values of 0%.

Use the CMYK mode when preparing an image to be printed using process colours. Converting an RGB image into CMYK creates a
colour separation. If you start with an RGB image, it’s best to edit first in RGB and then convert to CMYK at the end of your process. In RGB mode, you can use the Proof Setup commands to simulate the effects of a CMYK conversion without changing the actual image data. (See Soft-proofing colours.) You can also use CMYK mode to work directly with CMYK images scanned from high-end systems.

Although CMYK is a standard colour model, the exact range of colours represented can vary, depending on the press and printing conditions. Photoshop’s CMYK Colour mode varies according to the working space setting that you have specified in the Colour Settings dialog box.

1.4.3. Lab Colour Mode

In Photoshop, the Lab Colour mode has a lightness component (L) that can range from 0 to 100. In the Adobe Colour Picker, the ‘a’ component (green-red axis) and the ‘b’ component (blue-yellow axis) can range from +127 to -128. In the Colour palette, the ‘a’ component and the ‘b’ component can range from +120 to -120.

You can use the Lab mode to work with Photo CD images, edit the luminance and the colour values in an image independently, move images between systems, and print to PostScript Level 2 and Level 3 printers. To print Lab images to other colour PostScript devices, convert to CMYK first.

Lab images can be saved in Photoshop, Photoshop EPS, Large Document Format (PSB), PDF, Photoshop Raw, TIFF, Photoshop DCS 1.0 or Photoshop DCS 2.0 formats. 48-bit (16 bits per channel) Lab images can be saved in Photoshop, Large Document Format (PSB), Photoshop PDF, Photoshop Raw or TIFF formats.

Note: The DCS 1.0 and DCS 2.0 formats convert the file to CMYK when opened.

Lab colour is the intermediate colour model Photoshop uses when converting from one colour mode to another.
1.4.4. Bitmap Colour Mode
This mode uses one of two colour values (black or white) to represent the pixels in an image. Images in Bitmap mode are called bitmapped 1-bit images because they have a bit depth of 1.

1.4.5. Indexed Colour Mode
Indexed Colour mode produces 8-bit image files with at most 256 colours. When converting to indexed colour, Photoshop builds a colour lookup table (CLUT), which stores and indexes the colours in the image. If a colour in the original image does not appear in the table, the program chooses the closest one or uses dithering to simulate the colour using available colours.

By limiting the palette of colours, indexed colour can reduce file size while maintaining enough visual quality for certain applications like a multimedia presentation or a Web page. Limited editing is available in this mode. For extensive editing, you should convert temporarily to RGB mode. Indexed Colour files can be saved in Photoshop, BMP, GIF, Photoshop EPS, Large Document Format (PSB), PCX, Photoshop PDF, Photoshop Raw, Photoshop 2.0, PICT, PNG, Targa or TIFF formats.

1.4.6. Duotone Colour Mode
Duotone mode creates monotone, duotone (two-colour), tritone (three-color) and quadtone (four-color) greyscale images using two to four custom inks.

1.4.7. Multichannel Colour Mode
Multichannel mode uses 256 levels of grey in each channel. Multichannel images are useful for specialised printing. Multichannel mode images can be saved in Photoshop, Photoshop 2.0, Photoshop Raw, or Photoshop DCS 2.0 format.

These guidelines apply to converting images to Multichannel mode:
- Colour channels in the original image become spot colour channels in the converted image.
When you convert a colour image to multichannel, the new greyscale information is based on the colour values of the pixels in each channel.

Converting a CMYK image to multichannel creates cyan, magenta, yellow and black spot channels.

Converting an RGB image to multichannel creates cyan, magenta and yellow spot channels.

Deleting a channel from an RGB, CMYK or Lab image automatically converts the image to Multichannel mode. (See About colour channels for more information on channels.)

To export a multichannel image, save it in Photoshop DCS 2.0 format.

1.5. Hue, Saturation and Brightness

Hue, saturation and brightness are aspects of colour in the RGB scheme. These terms are most often used in reference to the colour of each pixel in a CRT display. All possible colours can be specified according to hue, saturation, and brightness (also called brilliance), just as colours can be represented in terms of the R, G and B components.

Most sources of visible light contain energy over a band of wavelengths. Hue is the wavelength within the visible-light spectrum at which the energy output from a source is greatest. This is shown as the peak of the curves in the accompanying graph of intensity versus wavelength. In this example, all three colours have the same hue, with a wavelength slightly longer than 500 nm, in the yellow-green portion of the spectrum.

Saturation is an expression for the relative bandwidth of the visible output from a light source. Saturation is represented by the steepness of the slopes of the curves. Here, the red curve represents
a colour having low saturation, the green curve represents a colour having greater saturation and the blue curve represents a colour with fairly high saturation. As saturation increases, colours appear more “pure”. As saturation decreases, colours appear more “washed-out”.

Brightness is a relative expression of the intensity of the energy output of the visible light source. It can be expressed as the total energy value or as the amplitude at the wavelength where the intensity is greatest (identical for all three curves). In the RGB colour model, the amplitudes of red, green and blue for a particular colour can each range from 0 to 100 percent of full brilliance. These levels are represented by the range of decimal numbers from 0 to 255 or hexadecimal numbers from 00 to FF.

In Photoshop the Hue/Saturation command lets you adjust the hue, saturation, and lightness of the entire image or of individual colour components in an image. Adjusting the hue, or colour, represents a move around the colour wheel. Adjusting the saturation, or purity of the colour, represents a move across its radius.

To use the Hue/Saturation command:

1. Open the Hue/Saturation dialog box.
The two colour bars in the dialog box represent the colours in their order on the colour wheel. The upper colour bar shows the colour before the adjustment; the lower bar shows how the adjustment affects all of the hues at full saturation.

2. To Edit in Photoshop, choose the colours to be adjusted.
   ❍ Choose Master to adjust all colours at once.
   ❍ Choose one of the other preset colour ranges listed for the colour you want to adjust. An adjustment slider appears between the

---

**Note**
The Threshold slider gives greater control for values between 0 and 128—the most common range for images—than for values between 128 and 255.
colour bars, which you can use to edit any range of hues. (For information on how to modify the slider’s range, see the instructions following this procedure.)

3. For Hue, enter a value or drag the slider until the colours appear as you desire.
   The values displayed in the text box reflect the number of degrees of rotation around the wheel from the pixel’s original colour. A positive value indicates clockwise rotation, while a negative value indicates counter clockwise rotation. Values can range from -180 to +180.

4. For Saturation, enter a value or drag the slider to the right or left to increase or decrease the saturation.
   The colour shifts away from or towards the centre of the wheel, relative to the beginning colour values of the selected pixels. Values can range from -100 to +100.

5. For Lightness, enter a value or drag the slider to the right or left to increase or decrease the lightness. Values can range from -100 to +100.

1.6. Red-eye Removal

Red-eye refers to an effect in photographs in which the eyes of people appear reddish in colour. This occurs due to reflection of the flash from the subjects’ eyes in the picture. To remove this effect in Photoshop, use the following steps.

1. Open the image.

2. Go to Image > Duplicate and close the original.

3. Go to Window > Documents > New Window. This will open a duplicate window of the same image.

4. Zoom one of the windows so that you can see the eyes as large as possible. Set the other window view to 100 per cent.
5. Arrange the two windows so you can see both the zoomed view and the 100 per cent view at the same time.

6. Create a new layer.

7. Use the eyedropper to pick up a colour from the iris of the eye. It should be a fairly grey tint with a hint of the eye colour.

8. Paint over the red part of the eye on the new layer, being careful not to paint over the eyelids.

9. Go to Filters > Blur > Gaussian Blur and give it about a 1 pixel blur to soften the edges.

10. Set the layer blend mode to Saturation. This will take the red out without removing the highlights, but in many cases it leaves the eyes too grey and hollow looking.

11. If that’s the case, duplicate the saturation layer and change the blend mode to Hue. That should put some colour back in, while still preserving the highlights.

12. If the colour is too strong after adding a Hue layer, lower the opacity of the Hue layer.

13. When you’re happy with the results you can merge the extra layers down.

Also keep the following in mind.

a. If you need to darken the pupil area, use the burn tool. It should only take a couple of taps with the burn tool to darken the pupils.
b. Before merging your layers, use the eraser tool to clean up any
overspray from painting outside the iris.

1.7. Noise removal

Noise is an effect in pictures which occurs due to poor lighting
and dusty atmosphere, causing them to look grainy.

Noise filters are used to remove noise, or pixels with randomly
distributed colour levels. This helps to blend a selection into the
surrounding pixels. Noise filters can create unusual textures or
remove problem areas such as dust and scratches from an image.
There are different techniques to remove noise.

1.7.1. Despeckle
Detects the edges in an image (areas where significant colour
changes occur) and blurs all the selection except those edges. This
blur-ring removes noise while preserving detail.

1.7.2. Dust & Scratches
These reduce noise by changing dissimilar pixels. To achieve a bal-
ance between sharpening the image and hiding defects, try vari-
ous combinations of radius and threshold settings. Or apply the
filter on selected areas in the image.

To use the Dust & Scratches filter in Photoshop:
2. If necessary, adjust the preview zoom ratio until the area con-
taining noise is visible.
3. Drag the Threshold slider left to 0 to turn off the value, so that
all pixels in the selection or image can be examined.

The Threshold determines how different the pixels’ values
should be before they are eliminated.
4. Drag the Radius slider left or right, or enter a pixel value in the text box from 1 to 16. The radius determines how far the filter searches for differences among pixels. Adjusting the radius makes the image blurry. Stop at the smallest value that eliminates these defects.

5. Increase the threshold gradually by entering a value or by dragging the slider to the highest value possible that eliminates defects.

1.7.3. Median
This reduces noise in an image by blending the brightness of pixels within a selection. The filter searches the radius of a pixel selection for pixels of similar brightness, discarding pixels that differ too much from adjacent pixels, and replaces the centre pixel with the median brightness value of the searched pixels. This filter is useful for eliminating or reducing the effect of motion on an image.

1.8. Image Effects

1.8.1. Sepia
Modern photographic prints do not suffer from such a severe discoloration effect over time, but if you take a photograph clicked 20 to 30 years ago, you are most likely to find that the colour has faded. This can be due to the dyes used in the ink, or the way the photograph was processed.

Sepia images have their characteristic brown nature right from development, because of a chemical reaction that occurs during processing. They are actually more colour-fast than normal colour prints, and should not fade much over time.

The Sepia effect is just as desirable nowadays as it always was, and more accessible techniques have been developed to give pho-
tographs this distinctive appearance. Originally the process involved adding a pigment made from the inky secretion of a Cuttlefish to the photograph during development, but other methods have since been devised using artificial toners.

For the scientifically inclined, the word “Sepia” comes from the genus of Cephalopod, which is a group of creatures including the cuttlefish. This is also why it has a capital letter.

If an image is truly Sepia toned, (by a strict Sepia definition), it must technically be completely monochrome. This means that it only contain shades of brown, much like a black and white photograph only contains shades of grey.

The advent of personal computers and digital home photography has created a way for almost anyone to achieve Sepia image toning. Digital photos can be edited with programs like Photoshop and Photoshop Elements to get the Sepia effect. To do this, use the following steps:

1. Open the image in Photoshop.

2. If the image is in colour, go to Image > Adjust > Desaturate and skip to step 4.
3. If the image is in greyscale go to Image > Mode > RGB Colour.

4. Go to Image > Adjust > Variations.

5. Move the Fine<-->Coarse slider down one notch less than the middle.

6. Click on More Yellow once.

7. Click on More Red once.

8. Click OK.

Some points to keep in mind:

a. Use the Save button in the Variations dialog to save the sepia tone settings. The next time you want to use it, just load the saved settings.

b. Use Desaturate and experiment with Variations to apply other colour tints to your photos.

1.8.2. Black And White

Converting a digital colour photo into black and white goes beyond simply desaturating the colours, and can be made to mimic any of a wide range of looks created by using colour filters in black and white film photography. Conversion which does not take into account an image's colour and subject of interest can dilute the artistic message, and may create an image which appears washed out or lacks tonal range. This section provides a background on using colour filters, and outlines several different black and white conversion techniques—comparing each in terms of their flexibility and ease of use.

Contrary to what one might initially assume, traditional black and white photographers actually have to be quite attentive to the type and distribution of colour in their subject.
Colour filters are often used in front of the lens to selectively block some colours while passing others (similar to how colour filters are used for each pixel in a digital camera’s bayer array). Filters are named after the hue of the colour which they pass, not the colour they block. These can block all but a primary colour such as red, green or blue, or can partially block any weighted combination of the primary colours (such as orange or yellow). Careful selection of these filters allows the photographer to decide which colours will produce the brightest or darkest tones.

Converting a digital colour photo into black and white utilises the same principles as with colour filters in film photography, except filters instead apply to each of the three RGB colour channels in a digital image. Whether you specify it or not, all conversion techniques have to use some weighted combination of each colour channel to produce greyscale brightness. Some techniques assume a combination for you, although the more powerful ones give you full control. Each makes its own trade-offs between power and ease of use, and so you may find that some techniques are best suited only to certain tasks.

The channel mixer tool in Photoshop allows the user to control how much each of the three colour channels (red, green and blue) contribute to the final greyscale brightness. It is undoubtedly one of the most powerful black and white conversion methods.
However, it may take some time to master since there are many parameters which require simultaneous adjustment. Use the following steps to convert a picture to black and white in Photoshop.

1. Open this tool by clicking on Image > Adjustments > Channel Mixer in Adobe Photoshop.

2. Be sure to first click on the lower left tick box entitled “Monochrome” for black and white conversion.

3. It is good to get a feel for the distribution of each colour channel by first setting each of the colour channels to 100 per cent individually.

4. Adjust each of the red, green and blue sliders to produce an image to your liking. For an even more pronounced effect, some colours can even have negative percentages.

5. The sum of the red, green and blue percentages need to equal 100% in order to maintain roughly constant brightness, although overall brightness can also be adjusted by using the “Constant” slider at the bottom. If the aim is to mimic the luminosity perceived by the human eye, set the values of Red, Green and Blue at 30%, 59% and 11%, respectively. This technique is particularly elegant because it allows you to apply from any of the entire spectrum of colour filters by just dragging the hue slider. This allows one to quickly assess which combination of colour filters work best, without necessarily having one in mind when starting. It takes a little longer to setup than the channel mixer, but is actually faster to use once in place.

6. Open the image in Photoshop and create two separate “Hue/Saturation Adjustment Layers” by following the menus: Layers > New Adjustment Layer > Hue/Saturation.

7. Each window will be named Hue/Saturation 1 or 2. However, I have given these custom names for this tutorial.
8. Set the blending mode to Colour on the top adjustment layer (Saturation) and set the saturation to its minimum of -100 as shown below.

9. On the bottom adjustment layer, change the “Hue” slider to apply any of the entire spectrum of colour filters. This is the main control for adjusting the look from this technique.

10. The saturation slider can also be adjusted in this layer, but this time it fine-tunes the magnitude of the filter effect for a given hue.

11. Once all adjustments have been made, merge/flatten the layers to make these final.

An alternative technique which may be a bit easier is to only add one Hue/Saturation adjustment layer and change the hue of the image itself. On the other hand, this does not allow one to go back and change the colour filter hue if it is no longer in Photoshop’s undo history (at least not without unnecessarily destroying the bit depth). Using the lightness channel in lab mode is quick and easy because it converts based on the luminance value from each pixel’s RGB combination. The steps are as follows:

1. First convert the image into the LAB colour space by clicking on Image > Mode > Lab Colour in Photoshop.

2. View the “Lightness” channel by clicking on it (as shown to the left) in the channel window. If not already open, the channel window can be accessed by clicking on Window > Channels.

3. Delete both the “a” and “b” channels to leave only the lightness channel (“a” and “b” refer the red-green and blue-yellow shift, or “chrominance”).

4. Note that the lightness channel may subsequently require significant levels adjustments as it may not utilize the entire tonal
range of the histogram. This is because it requires all three
colour channels to reach their maximum for clipping, as
opposed to just one of the three channels for an RGB histogram.

5. Desaturating the colours in an image is the simplest type of
conversion, but often produces inadequate results. This is
because it does not allow for control over how the primary
colours combine to produce a given greyscale brightness.
Despite this, it is probably the most commonly used way of con-
verting into black and white. In Photoshop, this is accom-
plished by going from Image > Adjustments >
Desaturate. Ordinarily, the best results are achieved when
the image has the correct white balance. Removal of colour
casts means that the colours will be more pure, and so the
results of any colour filter will be more pronounced.

Any black and white conversion which utilizes a significant
boost in colour saturation may begin to show artefacts, such as
increased noise, clipping or loss of texture detail. On the other
hand, higher colour saturations also mean that each colour filter
will have a more pronounced effect.

Recall that the noise levels in each colour channel can be quite
different, with the blue and green channels having the most and
least noise, respectively. Try to use as little of the blue channel as
possible to avoid excess noise.

Levels and curves can be used in conjunction with black and
white conversion to provide further control over tones and con-
trast. Keep in mind though, that some contrast adjustments can
only be made by choosing an appropriate colour filter, since this
adjusts relative contrast within and the colour regions. Care
should also be taken when using these because even slight colour
clipping in any of the individual colour channels can become
quite apparent in black and white depending on which channels
are used for conversion.
1.9. Printers

A computer printer, or more commonly a printer, produces a hard copy (permanent human-readable text and/or graphics) of documents stored in electronic form, usually on physical print media such as paper or transparencies. Many printers are primarily used as local computer peripherals, and are attached by a printer cable to a computer which serves as a document source.

In addition, many modern printers can directly interface to electronic media such as memory sticks or memory cards, or to image capture devices such as digital cameras and scanners. Some printers are combined with scanners and/or a fax in a single unit. Printers that include non-printing features are sometimes called Multi-Function Printers (MFP) or Multi-Function Devices (MFD).

A printer which is combined with a scanner can function as a photocopier if so designed. Most MFPs include printing, scanning and copying among their features.

A printer's speed is measured in PPM (pages per minute) and resolution in DPI (dots per inch). Resolution refers to the quality of the output of the printer. The greater the resolution, the greater is the quality. Printers use the CMYK colour mode, which offers the combinations of the colours cyan, magenta and yellow in addition to printing black and white (the K in CMYK is for the word black).

Printers are routinely classified by the underlying print technology they employ. Numerous such technologies have been developed over the years.

Toner-based printers work using the Xerographic principle that is at work in most photocopiers—by adhering toner to a light-sensitive print drum, then using static electricity to transfer the toner to the printing medium to which it is fused with heat and pressure.
The most common type of toner-based printer is the laser printer, which uses precision lasers to cause adherence. Laser printers are known for high quality prints, good print speed, and a low (Black and White) cost-per-copy. They are the most common printer for many general-purpose office applications. They are far less commonly used as consumer printers due to the high initial cost.

Laser printers are available in both colour and monochrome varieties. Another toner-based printer is the LED printer which uses an array of LEDs instead of a laser to cause toner adhesion to the print drum. Recent research has also indicated that Laser printers emit potentially dangerous ultra-fine particles, possibly causing health problems associated with respiration and cause pollution levels comparable to cigarettes. The degree of particle emissions varies with age, model and design of each printer, but is generally proportional to the amount of toner required. Furthermore, a well ventilated workspace would allow such ultra-fine particles to disperse, thus reducing the health side effects.

Inkjet printers spray very small, precise amounts (usually a few pico-litres) of ink onto the media. These droplets of ink will carry a slight electrical charge. The placement of the ink on the page is then determined by the charge of a cathode and electrode between which the ink moves towards the paper. Inkjet printing (and the related bubble-jet technology) are the most common—quality inkjet printers are inexpensive to produce.

Virtually all modern inkjet printers are colour devices. Some are known as photo printers and include extra pigments for improved reproduction of the colour gamut needed for high-quality photographic prints (and are additionally capable of printing on photographic card stock, as opposed to plain office paper).

Inkjet printers consist of nozzles that produce very small ink bubbles that turn into tiny droplets of ink. The dots formed are the size of tiny pixels. Inkjet printers can print high quality text.
and graphics. They are also almost silent in operation. Inkjet printers have a much lower initial cost than laser printers, but have a much higher cost-per-copy, as the ink needs to be frequently replaced.

In addition, consumer printer manufacturers have adapted a business model similar to that employed by razor blade manufacturers. The printers themselves are frequently sold below cost, and the ink is then sold at a high mark-up.

Various legal and technological means are employed to try and force users to purchase ink only from the manufacturer (thus leading to vendor lock-in). However there is a thriving aftermarket for such things as third-party ink cartridges (new or refurbished) and refill kits.

Inkjet printers are also far slower than laser printers. Inkjet printers also have the disadvantage that pages must be allowed to dry before being aggressively handled. Premature handling can cause the inks (which are adhered to the page in liquid form) to run.

Solid Ink printers, also known as phase-change printers, are a type of thermal transfer printer. They use solid sticks of CMYK coloured ink (similar in consistency to candle wax), which are melted and fed into a piezo-crystal operated print-head. The print head sprays the ink on a rotating, oil coated drum. The paper then passes over the print drum, at which time the image is transferred, or transfixed, to the page.

Solid Ink printers are most commonly used as colour office printers, and are excellent at printing on transparencies and other non-porous media. Solid ink printers can produce excellent results. Acquisition and operating costs are similar to laser printers. Drawbacks of the technology include high power consumption and long warm-up times from a cold state.
Also, some users complain that the resulting prints are difficult to write on (the wax tends to repel inks from pens), and are difficult to feed through Automatic Document Feeders, but these traits have been significantly reduced in later models.

A dye-sublimation printer (or dye-sub printer) is a printer which employs a printing process that uses heat to transfer the dye to a medium such as plastic cards, paper or canvas. The process is usually to lay one colour at a time using a ribbon that has colour panels. Dye-sub printers are intended primarily for high-quality colour applications, including colour photography, and are not as suitable for text. While once the province of high-end print shops, dye-sublimation printers are now increasingly used as dedicated consumer photo printers.

1.10. Online Image-editing Tools

In the last section of this chapter, we cover online image-editing Web sites. The last few years has seen the boom of online services on the Web. There are online messaging services, online file storage services and online social networking sites—so why not online image-editing sites. These sites are cool, offer features similar to image-editing tools like Photoshop, and some are free as well. Digit covers two of these sites—Picnik and Pixenate.

1.10.1. Picnik

Picnik is a really cool and free site which has basic photo-editing features from rotating, cropping and resizing images to adjustment of saturation, contrast and even red-eye removal. Using this site is very simple. Go to the site and upload your photo. Next, you will be taken to a Web page having a menu with the several options.

The rotate option allows for clockwise and anti-clockwise rotation of images and even flipping images horizontally or vertically. There is also a slider to make the image rotate by an angle of your
choice. Cropping gives the facility to select only that part of the image that you wish to use. Drag the selection area larger or smaller by using the mouse. Resizing the image can be done to change the resolution or the aspect ratio of the image.

The exposure menu option offers the feature of changing the contrast or exposure of the image. The colours option is to be used to adjust the saturation or the temperature of the image giving it a fuller appearance. Both are done using slider controls.

The sharpness of the image can be adjusted using the sharpness menu option. This is useful for noise-removal or improving the quality of grainy images. The red-eye removal menu option is used to remove the unwanted effects of a flash on the eyes of people who are present in the photo.

1.10.2. Pixenate
Pixenate is another great and free site for online image-editing. Not only does this site offer the features of cropping, resizing and rotating images, but also offers others like sepia, horizon adjustment, changing the lighting effect and even a zoom feature. Its GUI is more appealing than the Picnik GUI, where it provides a grid of thumbnails to operate on the images.

Operating this site is pretty much similar to Picnik. Simply upload an image and start working on it. Cropping, resizing and rotating are with little variation from Picnik. The sepia, whitening, red-eye removal, horizon-adjust and zoom are what are eye-catching in this site.
The whitening feature can be used to produce pearly-whites on the faces of smiling people. The horizon-adjust allows for tilting the picture at angles to the horizon in order to produce certain kinds of effects, and the zoom in and out thumbnails are great for picture magnification/shrinking.

Pixenate is quite snappy.
It’s hard to even think of “advanced image editing” without thinking Adobe Photoshop. For the purpose of this chapter, we’ll use Photoshop as a base—it’s the best for what we’re going to talk about, and the most widely used. Any product offering similar features borrows them from Photoshop anyway, so making the transition shouldn’t be difficult at all.
Even though it’s sometimes called RAW, the camera raw image format isn’t an acronym—it’s literal. A raw file contains all the unprocessed data collected by your camera’s sensors. It’s the most accurate representation of the photograph you took, and contains more color information than common image formats—specifically the JPEG format that most digital cameras use. Only high-end cameras record raw data (the rest convert the photo to JPEG before writing it to the memory card), so you’ll probably not work with this format unless you own a Digital SLR (DSLR).

Unlike standard formats like JPEG or TIFF, however, camera raw formats are specific to manufacturers, and would originally work only with software that was provided by them. Unfortunately, this software would invariably be badly designed, leading first to open source software like dcraw that reverse-engineered the proprietary raw formats, and then the introduction of Adobe’s DNG (Digital Negative) image format—a standard raw format for all cameras. Eventually, camera vendors relented, and while they didn’t adopt the DNG format, they did allow third-party software to be able to read their raw formats.

For all practical purposes, a raw file is the digital equivalent of the film negative, and just like you can use chemicals to develop the film the way you want, you can use software to “develop” your camera’s raw data to a format like TIFF. In either case, the negative remains intact, so you can start over if you don’t like the results.

2.1.1 Camera Raw In Photoshop
Adobe Photoshop supports the raw formats for nearly all popular digital camera manufacturers; you’ll have to download the

<table>
<thead>
<tr>
<th>RAW Image Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>.raw</td>
</tr>
<tr>
<td>.crw, .cr2</td>
</tr>
<tr>
<td>.tif, .dcr</td>
</tr>
<tr>
<td>.mrw</td>
</tr>
<tr>
<td>.nef</td>
</tr>
<tr>
<td>.orf</td>
</tr>
<tr>
<td>.dng</td>
</tr>
<tr>
<td>.ptx, .pef</td>
</tr>
<tr>
<td>.arw, .srf, .sr2</td>
</tr>
<tr>
<td>.raw</td>
</tr>
</tbody>
</table>
Camera Raw plugin from Adobe’s Web site to enable that support in versions before CS3. All you need now is the raw file.

When you open a raw image with Photoshop, you first get the Camera Raw dialog—think of this as the dark room where you prepare your photo. Here you can make adjustments to your photo before actually opening it, and without changing the original raw file.

At the top of the Camera Raw dialog is the toolbar, where you can choose standard tools like Zoom, Pan, Crop and so on. On the right are the Image Adjustment tabs—their function is self-explanatory.

**White Balance**
The first thing you should approach is the photo’s white balance. This setting’s also on your digital camera, but it’s better to leave the camera setting to Auto and make finer adjustments here. Put simply, adjusting your photo’s white balance is the act of determining what areas of the photo should be white, and then adjusting the remaining colours to ensure that those areas are indeed
white. For example, if you shoot a photo under a yellow tungsten lamp, all areas that should be white will have a yellow tinge to them, so you should tone down the yellow and boost the blue in the photo to get back to natural colours.

In the Image Adjustment area, you’ll see sliders for Temperature and Tint. A photo’s colour temperature is how “warm” or “cool” it looks—warm images look bathed in yellow, cooler images have a suffusion of blue. Use this slider only if your photo looks distinctly biased towards one end.

A better way to adjust white balance quickly is the White Balance tool—it’s the third from the left on the toolbar. Select it and click on the area of the image that is supposed to be white or neutral grey—the Temperature and Tint settings will automatically be adjusted.

**The Basic Image Adjustment Tab**

Besides adjusting white balance, the Basic tab gives you options to tweak the tone of your image.

**Exposure:**
This slider lets you adjust the brightness of the image, but setting it too high could murder details; ditto too low.

**Recovery:**
This slider lets you recover details from the brighter areas of the image—if the texture of a wall is obliterated by direct sunlight, for example, Recovery will try and get it back for you.

**Fill Light:**
Fill light is the same as Recovery, only for darker areas of the image. It’ll try to recover details from shadows in your photo, without turning blacks into grey.

**Blacks:**
The black level of a photo defines how dark an area needs to be to
be considered black. Raising that threshold will darken more areas of the image, so you can use this to get a high-contrast effect without actually boosting the lighter areas of the image.

**Brightness, Contrast:**
In Photoshop CS3, Brightness actually works differently from previous versions—instead of just adding white to the image, Brightness adjusts highlights and shadows so that neither ends up swallowing the entire image. The contrast slider, however, works exactly as you would expect it to.

**Clarity:**
This slider adds definition to the edges in your photo to give you crisper images.

**Saturation:**
This slider adjusts the intensity of all colours in the image.

**Vibrance:**
This slider adjusts saturation too, but it also prevents colours from getting too saturated.

When you’re done with basic adjustments, you can make finer tweaks to your image using Tone Curves.

**The Tone Curve Tab**
This is a little difficult to understand, but with a little experimentation, you can still get the effect you desire.

The horizontal axis of the graph represents the original tones of your photo, with the darkest on the left and getting lighter towards the right. The vertical axis represents the tone values after you’ve had your way with them. When the tone curve is a straight, 45-degree line, it means that the output image is the same as the input. Moving a point upward brightens the corresponding output, and moving it downward darkens it. You can use the sliders under Parametric to see the effect...
Use the Tone Curve to make fine adjustments to your image

of your changes on the tone curve, and then edit the curve yourself under Point.

The Detail Tab

As the name suggests, this is where you concentrate on the minute details of your photo, so you’ll need to zoom into the image to see

You’ll have to zoom in really close to see the effects of the Detail tab, but they’re there
the effects in action. The Sharpening sliders are the same as the Smart Sharpen filter in Photoshop.

**Amount:**
This is the strength of the sharpening filter that will be applied.

**Radius:**
this is number of surrounding pixels that are affected by the sharpen filter. The higher the value, the more prominent the effect.

**The HSL / Greyscale Tab**

You can even tweak the way you convert an image to greyscale

Here’s where you make colour adjustments to your images. Each of the three tabs—Hue, Saturation and Luminance—has sliders for eight basic colours; here’s what happens to them when you adjust one of the three parameters:

**Hue:**
Dragging any one of the sliders under the Hue tab changes the colour of the image—you can drag the Greens slider, for instance,
and replace all greens in the image with yellows or cyan (depending on the direction you drag in).

**Saturation:**
when you drag a saturation slider for a colour, you increase that colour's intensity in your image.

**Luminance:**
with the Luminance slider, you can adjust the colour's brightness in your image.

To convert your image to greyscale, check the box at the top. You can now use the sliders to tweak the conversion—if you want blues to be converted into light areas, drag the Blue slider to the left.

**The Split Toning Tab**
You can use the Split Toning tab to convert a greyscale image into a two-tone image. You can use the Hue and Saturation sliders to choose the colour and its brightness for Highlights and Shadows.
separately, and then use the Balance slider to tweak how the two colours mingle with each other.

**The Lens Corrections Tab**

Very often, imperfections in your camera’s lens can cause defects in your images—specifically at the edges. This is called a Lens Vignette can be used to draw attention to the centre of the image.
Chromatic Aberration, and is caused when the different colours of light take different paths after passing through the lens. To understand this better, let’s turn to a simple concept we all first encountered in school...

We all know that when white light passes through a prism, it breaks up into its constituent colours. This is because different wavelengths of light bend at different angles when they pass through another medium—in this case, glass. The same thing happens when light passes through a lens. In cameras, manufacturers avoid this by using compound lenses, which compensate for the dispersion of light and bring the component wavelengths back together. Unfortunately, things could go wrong sometimes, and you can find yourself looking at a photo with a bluish fringe along the edges of objects.

This is where the Lens Corrections Tab comes in: the two sliders under Chromatic Aberration let you correct any fringing you may see in your photo. In addition, you can use the Lens Vignetting slider to create a dark or light area at the edges of your image to focus on the centre, or eliminate that effect if your camera has caused it and you don’t want it.

The Camera Calibration Tab
Under this tab, you can tweak the colour settings for your camera using the Hue and Saturation slider for the red, green and blue colour channels. When you’re satisfied with the result and want to use your new settings for every photo taken by the same camera, click on the small icon on the top-right of the tab and choose Save New Camera Raw Defaults.

The Straighten Tool
If you shot your photo a little crooked, you can fix its orientation using the straighten tool—it’s the sixth from the left on the main toolbar. Just click and drag along what should be the straight edge of your photo, and you’ll get a box that shows you the area that’ll represent your final photo. Depending on how crooked the
2.2 Advanced Image Editing

In the last chapter, we explored basic image effects and how to correct minor problems with your images. This works even with basic software like IrfanView, but when things are "very" wrong with your images, you need to turn to more advanced tools like Photoshop or Paint Shop Pro. The most common problem you'll have to deal with is a dull, boring image.

Using Levels To Brighten Up An Image

Let's consider the image you see open in Photoshop here. It may not show in greyscale, but you can take our word for the fact that it doesn't have much impact, and as with many mountain pictures, has a blue haze that we simply cannot approve of.

The solution's rather simple: we need to play with the Levels dialog (Ctrl + L) to get the result we want (which is sharp,
vibrant and haze-free). When you open the dialog, you’re presented with a Histogram, which shows how the colours in the image are distributed between fully black and fully white. This will make more sense if you choose one of the channels from the drop-down menu. The histogram for the Blue channel, for example (shown here), shows that the most widely distributed shade of blue is around the 50 per cent mark.

A good histogram covers all intensities—it means that the image has pixels that cover the full range of colour for each channel. A flat area on the left means that there aren’t enough dark pixels, leaving the image looking washed out (which is what we have in this case). Conversely, a flat area on the right will look too dark and dull. The solution to our problem is to drag the black slider from the extreme left to the beginning of the histogram—for each channel. This simple activity results in a massive improvement in the image.
The histogram for the blue channel

The result. You’ll have to take our word for this one too—it’s improved plenty.
A Bit Of Colour Correction

We’ll continue with the image that we get after applying the Levels adjustment—the image still has more blue than we’d like. For this, we turn to the Hue / Saturation dialog.

At the bottom of the dialog, you’ll find two colour bars. When you drag the Hue slider, the bottom bar moves, and the colours in the image that correspond to the top bar get replaced by the colour directly below on the bottom bar. For example, if you drag the Hue slider so that the yellow region of the bottom bar is below the red region of the top, then the reds in the image will be replaced by yellows. This is good if your image is filled with a colour it’s not supposed to be.

You can also use this dialog to tone up or down any colour that seems to be dominating (or missing from) your image. From the drop-down, select the colour you want to manipulate—Yellows, for example. When you use the Saturation slider now, you’ll see the intensity of the yellows in the image increase or reduce.

Use the Hue / Saturation dialog to correct the tone of your image.
Compositing

Compositing, as the very term goes, is the process of superimposing one image over another image to create a new image. Take, for example, an air conditioner manufacturer who plans an ad campaign for their latest range of ACs, which they claim cools the room well enough to make it really chilly. They intend to depict something that seems to make the Eskimos
really feel at home. This campaign just comes alive with a bunch of Eskimos in backdrop of the icy cold North Pole. But for a seasonal ad campaign, is it really necessary to go up there? That apart, equipment and crew, transport, formalities and other ancillary costs would drive the budget way beyond scope. If you can get the same effect in a fraction of the cost, what better than that? Use Adobe Photoshop and you have a ready and effective solution to all your needs.

3.1 The Concept Of Layers

While writing this article, it is easy to edit a few words here and there without disturbing the rest of the document. But, doing the same with images? We doubt in spite of their talent, even Michelangelo or Raphael would have preferred to rework! This is where layers come into play. Let us take the same example of the ad for ACs. Let’s assume we have the close-ups of the AC we want to sell. We also have a beautiful backdrop of the ice-laden scenic view of the North Pole. Rather than drawing a picture of the AC on the frame of the cold environment, the best and time tested option is to superimpose the two, such that you can move the AC around anytime you want, depending on which location best suits your concept. This is possible using layers. Let us take another example to understand this better. We all have worked on MS Paint. You know how painful it is, if after creating your masterpiece in it, you were told that you needed the AC on the left instead of the right. If you’re working on a white background, you might just save your skin, but you may not be lucky that often. This is where you get to know the true power of layers—all you’d have to do is move the layer on which you pasted the AC. It’s like a bunch of transparency sheets stacked together—depending on their positioning, you see the final picture.

Layers are used to reduce the effect of mistakes, and preventing the original image from being damaged. You can protect the original image by creating the first layer. Create a copy of the back-
ground picture by dragging it to the Create New Layer icon. Next, create a new blank layer by clicking on the Create New Layer icon on the layers palette. The icon looks like a blank page. Even if you go to the brush tool, and draw all over the picture, the original is not damaged. If you click on the eye next to this new layer, the layer will disappear. Similarly, to bring the layer back, click on the empty box. You can also move and hide the layer below the background copy. To delete a layer, click and hold down on the layer icon and drag it to the little trash icon. There’s our background copy and background original untouched.

There is a lot more you can do with layers. To get familiar, practice creating them and moving them around.

### 3.2 Alpha Channels And Layer Masks

Images are made up of three colours—Red, Green and Blue—called channels in image-editing circles. All channels are greyscale. If the image is going to be used for online content, where it has to be displayed on a screen, then the image is split into RGB channels, where R, G and B indicate Red, Green and Blue, respectively. Similarly, when the image has to be used for printing, they are split up into 4 channels, each for the ink that is used in printing. These are Cyan, Magenta, Yellow and Black.

The greyscale in the channels basically represent the intensity of that particular colour.

#### 3.2.1 Masks

Pretty similar to what masks do in real life, this principle is very actively used in compositing. Masking is used to determine self-laid limits to our playing around on the images. For example, with several smaller images of friends forming a single image, a mask may be used to highlight just the faces. The advantage of this is that any amount of altering or even non-inviting attire would not show up in the final image! Alpha channels and layer masks are
closely related. Be it RGB channels or CMYK channels, when each channel is isolated, there are lighter and darker areas in each of them. In any channel, there are grey as well as white areas. The white areas indicate that there is maximum red content in that particular region of the image. Similarly, the black areas indicate that there is no red content in that particular region of the image. Alpha channels are similar—the difference being that instead of corresponding to colour, alpha channels correspond to variations in transparency. Therefore, white areas correspond to absolute transparency while black areas correspond to opacity in the specific regions of the image.

So what is the advantage of using masks? Well, it is better to have no-so-important information hidden, rather than no having information that could be required any moment. Put in a simpler way—it is wiser to hide the birds and a few stray animals in the backdrop of scenery that does not seem appealing, rather than using an image that doesn’t have any of these elements. It is easier to hide, rather than create birds and animals to improve the image.

### 3.3 Layer Blending Modes

Layer blending refers to the extent the overlapping layers interact with each other to yield the broader final picture. So say you have a layer containing the image of a lady, while on the second layer you have the image of a fish, you can easily create the effect of a mermaid by reducing the opacity of both layers, towards the middle. Effectively, the two layers merge towards the centre.

**Tutorial for layer blending modes**

There is a pop-up menu on the Layers Palette, generally untouched by newbies to Photoshop—terms such as Multiply and Screen do sound unconventional with images—but as you go about playing with Photoshop, you see how they fit together.
A Closer Look
In order to get a feel of layer blending modes, the basic requirement is a couple of images on two layers. For this exercise, we will use two images. The image at the base layer is the star-shaped image, while the spiral-shaped image is on the upper layer. This base image is in Normal mode at 100 per cent opacity. The other layer is placed above the base image. We will apply all changes to this layer, especially effects like half-opacity.

Normal
When a pattern is set at normal mode and 100 per cent opacity, we wouldn’t see the shape image at all. To get a glimpse of the base layer, you have to reduce the opacity of the upper layer. After reducing the opacity of the upper layer to 50 per cent, which effectively means half transparency, the base layer begins to show up.

Dissolve
In order to use Dissolve, the opacity of the top layer should be less than 100 per cent.

Multiply
A colour in an RGB image is made of three colour channels, each
of which has a numerical value. RGB is an additive colour mixing system—this means that different proportions of these three colours cumulatively result in new colours. Each channel at full strength combines to make white and each channel at zero strength results in Black. For each colour, the maximum value is 255. The value 255 refers to 100 per cent.

Now that you have seen the numbers involved with colour, you can apply the arithmetic that you know! As the name says, the Multiply blending mode multiplies the base colour by the blend colour to yield the resultant colour. It always results in darker hues. But how could colours get multiplied? It’s precisely the multiplication of the values of the colours.

Screen
Now that you have seen how the Multiply effect works, you will notice that the Screen effect is exactly the opposite. Screen performs the exact same multiplication steps as Multiply, except that every numerical value is replaced with its inverse.
Overlay
The Overlay effect is between the results of Multiply and Screen. However, it lets the base image stand out more—this is because it uses the Multiply mode on the shadows, and uses Screen on the highlights.

Soft Light
The soft light effect works by using the blend image as a light source (a Soft Light) for the base image. So, if the blend colour has a brightness of more than 50 per cent, then the base colour gets lightened. Similarly, if the blend image’s colour is darker than 50 per cent then the base image’s colour gets darkened a little.

3.4 Creating Collages
Collaging is the process of pasting various materials not normally associated with one another, on to a single surface. This could include, parts of photographs, newspaper clippings, bits of images—all put together to form a completely different image.

Collaging A Garden
We’ll start with a rather plain picture of a garden, and liven it up—a little furniture, a bird bath, a bird (well, a rubber duck), and since Easter was not too long ago, we’ll even throw in an egg. The pictures are easy enough to obtain—
a Google image search—but if you want to use them for any purpose other than personal, you’re better off heading to http://www.morguefile.com.

1. First open all the images in Photoshop. One by one, click drag the Background layer of each image on to the picture of the garden—this will create a new layer for each. We’ll start with the furniture, so hide all the remaining layers by clicking on the eye icon next to them.

2. Now to create a mask for the furniture layer. Select the layer and click on the Create Layer Mask button at the bottom. Click on the mask’s thumbnail to start editing it. Using the paintbrush (B), select black as the foreground colour (hit [X] to switch the foreground and background colour) and begin painting out the areas you don’t want (the portions of the image that aren’t furniture).

3. Finally, the furniture is too large, so we need to resize it, and then place it where we want it. To resize, go to Edit > Transform > Scale. Hold down [Shift] and drag the handles at the corner to resize the layer. You can also move the layer around while you’re at it. Hit [Enter].
when you’re done. Hide this layer, and make the bird bath layer visible.

4. We’re lucky here—the image of the bird bath has a simple background, so we can eliminate it easily using the Magic Wand ([W]). Click on the background, and you’ll see that most of it gets selected. To include the few spots that aren’t selected, use Select > Grow.

5. Hit [Delete] to clear the background, and keep using this method to remove any remaining background areas. Use Transform again to scale the layer and place it where you want it.

6. Use the same method for the giant rubber duck and the Easter egg.

3.5 Stitching Images Together

A very useful application of compositing is the panorama. Nowadays, most digital cameras even implement this as a function. Panoramas are a way of covering a much larger area than your camera’s capable of by taking photos of parts of the area you want to cover, and then merge the photos together. For better panoramas, capture the images for your panorama in the vertical orientation, and such that they have 50 per cent overlap. Photoshop CS3 has a feature that lets you stitch images together for panoramas really easily. Here’s how you do it:

1. Go to File > Scripts > Load files into Stack. This lets you open the images that will make up your panorama in a single file, with each image on a separate layer.
2. Select all the layers—select the topmost, hold down [Shift] and select the last.

3. Go to Edit > Auto-Align Layers, leave the selection to Auto, click OK and wait. Your images will be aligned into a panorama, but there will likely be differences in colour tone across them.

4. With all the layers selected, go to Edit > Auto-Blend Layers—that takes care of the colour tone. You’re done!

The images are well-aligned, but you can still tell where one ends and the next begins.

It’s like you really shot it that way.
If Photoshop isn’t your cup of tea, there are many programs that let you create panoramas with even more ease. One such tool is Autostitch (http://www.cs.ubc.ca/~mbrown/autostitch/autostitch.html). It’s a tiny 1.1 MB download and has only one function—point it to your images, and it’ll create a panorama for you. The results can be a little unpredictable, though.
Now that we know something about graphics and images, let's switch to an interesting subtopic—vector graphics. Images are of two types—raster graphics and vector graphics. Raster graphics are those images in which information about each pixel is stored as a sequence of bytes. Vector graphics are essentially images in which information is quantized into points, lines, polygons,
curves and other geometric shapes and then stored in image files. In this chapter, we start with drawing tools, move on to vector graphic essentials and then finally see some tools for creating and editing vector graphics.

4.1. Graphics Tablets

A graphics tablet (or digitising tablet, graphics pad, drawing tablet) is a computer input device that allows you to hand-draw images and graphics, similar to sketching with pencil and paper.

A graphics tablet consists of a flat surface upon which the user may "draw" an image using an attached stylus, a pen-like drawing apparatus. The image generally does not appear on the tablet itself, but is rather displayed on the computer monitor.

Some tablets are intended as a replacement for the mouse as the primary pointing and navigation device for desktop computers.

Early graphics tablets are most commonly known as spark or acoustic tablets and are used as a stylus that generated clicks with a spark plug. The clicks were then triangulated by a series of microphones to locate the pen in space. The system was fairly complex and expensive, and the sensors were susceptible to interference by external noise.

Types Of Graphics Tablets

Passive tablets
Passive tablets, most notably those by Wacom, make use of electromagnetic induction technology, where the horizontal and vertical wires of the tablet operate as both transmitting and receiving coils (as opposed to the wires of the RAND Tablet which only transmit). The tablet generates an electromagnetic signal, which is received by the LC circuit in the pen. The wires in the tablet then change to a receiving mode and read the signal generated by the pen. Modern arrangements also provide pressure sensitivity and one or more switches (similar to the buttons on a mouse), with the electronics
for this information present in the pen itself, not the tablet. On older tablets, changing the pressure on the pen nub or pressing a switch changed the properties of the LC circuit, affecting the signal generated by the pen, which modern ones often encode as a digital data stream onto the signal. By using electromagnetic signals, the tablet detects the stylus position without the need for the stylus to even touch the surface. Powering the pen with this signal means that devices used with the tablet never need batteries. Wacom’s patents prevent their competitors to employ such techniques.

Active Tablets
The difference in active tablets is that the stylus used contains self-powered electronics that generate and transmit a signal to the tablet. These pens rely on an internal battery rather than the tablet for their power, resulting in a bulkier pen. Eliminating the need to power the pen means that such tablets may listen for pen signals constantly, as they do not have to alternate between transmit and receive modes, which can result in less jitter.

For both technologies, the tablet uses the received signal to determine the distance of the stylus from the surface of the tablet, the tilt (angle from vertical) of the stylus, and as well as other information in addition to the horizontal and vertical positions.

Compared to a resistive or capacitive touch screen, a graphics tablet offers improved precision, with the ability to track an object not touching the tablet, and can gather significant information about the stylus, but at the same time is more expensive, and can only be used with the special stylus or other accessories.

Some tablets, especially inexpensive ones aimed at young children, come with a cabled stylus, using technology similar to older RAND tablets, although this design is no longer used on any normal tablets.

Graphics tablets come with accessories too. The initial accessories were special mouse-like pucks designed for CAD applica-
tions, typically with a clear plastic area containing crosshairs for precise tracing of drawings, followed by a basic stylus. Today, a graphics tablet is equipped with a stylus for all models and a mouse for all but the cheapest or smallest models, and typically has a wide variety of other accessories available too. Many tablets use a digital data stream to encode information on the pen, often transmitting a unique serial number, allowing the software to recognize if the user has multiple input devices, and assigns different properties (brush type, colour, etc) to each device.

4.1.1. Stylus
A modern stylus has a pressure sensitive tip capable of sensing many levels of pressure against the tablet. A very inexpensive tablet might be able to sense 256 levels of pressure, while a normal tablet 512 levels, and a professional tablet a full 1024 levels of pressure. The increase in sensitivity of the tablet tip allows more precise control, especially if software scaling is used to allow a large response to a mild increase in pressure. High-end tablets also measure the tilt of the pen, giving the angle from vertical along both the X and Y axis (typically up to 60 degrees), allowing the graphics program to change the shape or other attributes of the brush depending on how the stylus is held. Some manufacturers also sell a stylus that uses a ball-point pen cartridge in the tip, allowing the user to place a sheet of paper onto the tablet, and draw a hard-copy on the paper in addition to the digitised version.

4.1.2. Stylus Eraser
Many modern styli have an eraser-shaped tip on the top of the pen, and additional circuitry to allow the pen to be used upside-down with the eraser end against the tablet, often very similar or identical to the circuitry used for the tip. The pressure-sensitive eraser is typically assigned a function similar to a real eraser, removing recent or all layers of colouring from the image, although it can be assigned other functions, such as a differently shaped brush, a selection tool, or some other feature of the application.
4.1.3. Mouse

Unlike a regular computer mouse, a graphics tablet mouse is capable of being used in "absolute mode", where the position of the mouse on the screen directly corresponds with its physical location on the tablet, or in "relative mode", where it emulates a regular mouse, for high-speed pointing. Graphics tablet mice typically contain several buttons, and often pressure-sensitive thumb wheels or other controls allow similar capabilities as the pressure-sensitive tip of a stylus. Many tablets can also detect the rotation of the mouse on the tablet, allowing applications to use this data.

4.1.4. Puck

A puck is typically distinguished from a mouse as having crosshairs for accurately tracing diagrams, a large number of buttons (12 buttons laid out similar to a telephone pad is not uncommon), or other features aimed at CAD usage. They are far less common than a regular tablet mouse, and are only available for some tablets.

4.1.5. Airbrush

Some tablets come with a specialty stylus designed to emulate an airbrush, often with additional finger-operated wheels to mimic the paint flow, nozzle shape, and other adjustments found on the genuine article. These are significantly less common than a regular stylus, and are often much more expensive.

4.1.6. Art Pens

Like a regular stylus, they typically resemble a pen with a pressure-sensitive tip, but have additional features, such as allowing the tablet to recognize the rotation of the pen in addition to the standard tilt and pressure, allowing the application to rotate the brush, reshape, or otherwise make use of this additional information, often to generate more realistic brush strokes.

Graphics tablets, because of their stylus-based interface and ability to detect some or all of pressure, tilt, and other attributes of the stylus and its interaction with the tablet, are widely consid-
ered to offer a very natural way to create computer graphics, especially two-dimensional computer graphics. Indeed, many graphics packages (e.g. The GIMP, Corel Painter, Photoshop, Pixel Image editor, Studio Artist and others) are able to make use of the pressure (and, in some cases, stylus tilt or rotation) information generated by a tablet, by modifying the brush size, shape, opacity, colour or other attributes based on data received from the graphics tablet.

In East Asia, graphics tablets, or pen tablets as they are known, are widely used in conjunction with input method editor software (IMEs) to write Chinese, Japanese, Korean (CJK) characters. The technology is popular and inexpensive. This technology enables natural interaction with the computer in a more natural manner, rather than typing on the keyboard.

Tablets are also popular for technical drawings and CAD, as one can put a piece of paper on them without interfering with their function.

Many of the most successful Web comic artists use tablets, including Hawk of Apple Geeks, Jorge Cham of Piled Higher and Deeper, Tim of Ctrl+Alt+Del and Gabe of Penny Arcade, who use graphics tablets to colour directly.

Finally, tablets are gaining popularity as a replacement for the mouse as a pointing device. They are more intuitive to some users than the mouse, as the position of the pen on the tablet typically corresponds to the location of the pointer on the GUI shown on the computer screen. Graphics tablets are available in various sizes and price ranges. A6-sized tablets are relatively inexpensive and A3-sized tablets are comparatively more expensive. Modern tablets usually connect to the computer via a USB interface.

Advocates of tablets and pens cite relief from occupational overuse syndrome varieties such as repetitive strain injury. Sufferers of carpel tunnel syndrome also report good results. This is because the use of computer mice tends to be very repetitive on
the wrist, whereas operating a pen is more natural and tends to involve the movement of the entire arm.

Some interactive whiteboards operate on the induction principle with some brands offering high resolution wall size graphic tablets up to 95 inch along with options for pressure and multiple-input based on different resonance patterns from tuned pens. Interactive whiteboards are proving to be immensely popular in schools in the UK, US and Mexico.

Touch screens like those found on some Tablet PCs and the Nintendo DSs are also similar, but they normally use optical grids or pressure sensitive films instead, and therefore do not need special pointing devices.

Some of the popular brands of graphic tablets in India are Wacom, Duotone, and Genius.

4.2. Vector Graphics Essentials

Vector art is an exciting digital art format that creates images using mathematical points, angles and shapes. Unlike raster art that uses pixel-based graphics to create images, vector art does not degrade when it is enlarged. This gives you—the artist, a tool that allows you to be extremely precise and creative at the same time.

Vector graphics (also called geometric modelling or object-oriented graphics) is the use of geometrical primitives such as points, lines, curves, and polygons, which are all based upon mathematical equations to represent images in computer graphics.

Vector graphics is an alternative to raster graphics, which is the representation of images as an array of pixels, and is typically used for the representation of photographic images.

Most computer displays translate vector representations of an image to a raster format. The drawing software is used for creating
and editing the vector graphics. The image can be changed by editing these objects. They can be stretched, twisted, coloured and so on, with a series of tools. The raster image containing a value for every pixel on the screen is stored in memory. Starting in the earliest days of computing in the 1950s and through the 1980s, a different type of display, the vector graphics system, was used. In these “calligraphic” systems, the electron beam of the CRT display monitor was steered directly to trace out the shapes required, line segment by line segment, with the rest of the screen remaining black. This process was practiced several times a second ("stroke refresh") to achieve a flicker-free or near flicker-free picture. These systems allow very high-resolution line art and moving images to be displayed without the (for that time) unthinkably huge amounts of memory that an equivalent-resolution raster system would have needed, and allowed entire sub-pictures to be moved, rotated, blinked, etc. by modifying only a few words of the graphic data "display file". These vector-based monitors are also known as XY displays.

A special type of vector display is known as the storage tube, which has a video tube is similar to Etch-a-Sketch. As the electron beam moves across the screen, an array of small low-power electron
flood guns keep the path of the beam continuously illuminated. This allows the video display itself to act as memory storage for the computer. The detail and resolution of the image can be very high, and the vector computer slowly paints out paragraphs of text and complex images in a few minutes, while the storage display kept the previously written parts continuously visible. The image retention of a storage display can last for several hours with the vector storage display powered, but the screen can be cleared instantly with the push of a button or a signal from the driving vector computer.

Vectorising is good for removing unnecessary detail from a photograph. This is useful for information graphics or line art (images were converted to JPEG for display on this page). Detail can be added or removed from vector art and vector illustrations can have their own colours, allowing artists to achieve desired results.

Modern vector graphic displays can sometimes be found at laser light shows, using two fast-moving XY mirrors to rapidly draw shapes and text on a large screen. The term vector graphics is mainly used today in the context of two-dimensional computer graphics. It is one of several modes an artist can use, to create an image on a raster display. Other modes include text, multimedia and 3D-rendering. Virtually all modern 3D-rendering is done using extensions of 2D vector graphics techniques. Plotters used in technical drawings still draw vectors directly on paper.

For example, consider a circle with radius r. The main elements of information a program needs in order to draw this circle are as follows.

- The following data describe a circle
- The radius r and equation of the circle
- The location of the centre of the circle
- Stroke line style and colour (possibly transparent)
- Fill style and colour (possibly transparent)
- Advantages to this style of drawing over raster graphics:

This minimal amount of information translates to a much smaller file size compared to large raster images (the size of rep-
representation doesn’t depend on the dimensions of the object, though a vector graphic with a small file size is often said to lack detail as compared to an actual photo.

Similarly, one can indefinitely zoom in to the arc of a circle, and it still remains smooth. On the other hand, a polygon representing a curve will reveal that it is not really curved.

On zooming in, lines and curves need not get wider proportionally. Often the width is either not increased or less than proportional. On the other hand, irregular curves represented by simple geometric shapes may be made proportionally wider when zooming in, to keep them looking smooth and not like these geometric shapes.

The object parameters are stored and can be modified later. This means that moving, scaling, rotating or filling doesn’t degrade the quality of a drawing. Moreover, it is normal to specify the dimensions in device-independent units, which results in the best possible rasterisation on raster devices.

From a 3-D perspective, rendering shadows is also much more realistic with vector graphics, as shadows can be abstracted into the light rays forming them. This allows for photo realistic images and renderings.

Typical primitive objects
- Lines and polylines
- Polygons
- Circles and ellipses
- Bezier curves
- Bezigrons
- Text (in computer fonts such as True Type where each letter is created from Bezier curves)

This list is not complete. There are various types of curves, which are useful in certain applications.
Often, a bitmap image is considered as a primitive object. From the conceptual view, it behaves as a rectangle.

Vector graphics editors typically allow rotation, movement, mirroring, stretching, skewing, affine transformations, changing of z-order and combination of primitives into more complex objects.

More sophisticated transformations include set operations on closed shapes (union difference, intersection, etc.).

Vector graphics are ideal for simple or composite drawings that need to be device-independent, or do not need photo-realism. PostScript and PDF page description languages use a vector graphics model.

Advanced vector artists develop more photo-realistic vector art every day. Vector art is important for printing. Since the art is made from a series of mathematical curves it will print very crisp even when resized. For instance, one can take the same vector logo and print it on a business card, and then enlarge it to billboard size and keep the same crisp quality. A low-resolution raster graphic would blur incredibly if it were enlarged from business card size to billboard size.

In 3D computer graphics, vectorised surface representations are most common (bitmaps can be used for special purposes such as surface texturing, height-field data and bump mapping). At the low-
end, simple meshes of polygons are used to represent geometric detail in applications where interactive frame rates or simplicity are important. At the high-end, where one is willing to trade-off higher rendering times for increased image quality and precision, smooth surface representations such as Bezier patches, NURBS or sub-division surfaces are used. However, you can achieve smooth surface rendering from a polygonal mesh through the use of shading algorithms such as Phong and Gouraud.

An example of vector graphics format is SVG (Scalable Vector Graphics), an open standard created and developed by the World Wide Web Consortium (and attempts of several corporations) to address the need for a versatile, scriptable and all-purpose vector format for the Web and otherwise. Another example is VML, a proposed standard that was adopted by Microsoft.

Scalable Vector Graphics (SVG), aka “savage”, is an XML specification and file format for describing two-dimensional vector graphics, both static and animated. SVG can be purely declarative and may include scripting. Images can contain hyperlinks using outbound simple XLinks. It is an open standard created by the World Wide Web Consortium’s SVG Working Group.

SVG was developed around 1999-2008 by a group of companies within the W3C after the competing standards PGML (developed from Adobe’s PostScript) and VML (developed from Microsoft’s RTF) were submitted to W3C in 1998. SVG drew on experience designing both those formats.
This image illustrates the difference between bitmap and vector images. The vector image can be scaled indefinitely without loss of image quality, while the bitmap cannot.

**SVG allows three types of graphic objects:**
- Vector Graphics
- Raster Graphics
- Text

Graphical objects can be grouped, styled, transformed and composited into previously rendered objects. SVG does not directly support z-indices that separate drawing order from document order for objects, which is a drawback with respect to other vector mark-up languages like VML. Text can be in any XML namespace suitable to the application, which enhances searchability and accessibility of the SVG graphics. The feature set includes nested transformations, clipping paths, alpha masks, filter effects, template objects and extensibility.

While being primarily designated as a vector graphics mark-up language, the specification is also designed with the basic capabilities of a page description language, similar to Adobe's PDF. It contains provisions for rich graphics, and is also compatible with the CSS specification’s properties for styling purposes. Therefore, unlike XHTML and XSL-FO which are layout-oriented languages, SVG is a fully presentation-oriented language. A much more print-specialized subset of SVG known as SVG Print (authored by Canon, HP, Adobe and Corel) is currently a W3C working draft.

SVG drawings can be dynamic and interactive. Time-based modifications to the elements can be described in SMIL, or can be programmed in a scripting language (e.g., ECMAScript). The W3C explicitly recommends SMIL as the standard for animation in SVG. However, it is common to find SVG animated with ECMAScript because it is a language that many developers already understand, and is more compatible with existing renderers. A rich set of event
handlers such as onmouseover and onclick can be assigned to any SVG graphical object.

SVG images, being XML, contain many repeated fragments of text and are particularly suited for compression. Once an SVG image has been compressed, it may be referred to as an “SVGZ” image, with the corresponding filename extension. The resulting file may be as small as 20% of the original size.

The use of SVG on the Web is in its infancy. There is a great deal of inertia due to the long-time use of pure raster formats and other formats like Adobe Flash or Java applets, and browser support for SVG is still uneven. However, there are available a number of third-party plug-ins available for SVG.

### 4.3. Corners And Points In Vector Graphics

A vector image consists of the anchor points and the segments that join them. A single set of anchor points and segments is a contour and an individual vector object may consist of one or more contours and is called a path.

Segments can be either straight or curved, and anchor points define segment ends. Bezier curves are a compact way of mathematically describing a curved segment, which are based on the location of the anchor points that define the segment’s ends and on direction lines that describe the angle and length of the curve.

Anchor points come in two basic types, those with curves and those without curves. A sharp corner is called a cusp. A cusp or corner point’s curve handles can be manipulated totally independent of each other. That is, moving one has no effect on the other. The asymmetric and symmetric anchor points are called smooth curves. In the case of asymmetric points, the control handles can be lengthened or shortened independent of each other. However, if you try changing the direction of one, then
the other follow—keeping both handles in a straight line. It’s not possible to make the same pointy shape possible with the cusp point.

With a symmetric anchor point, the curve handles behave similar to Newton’s Third Law of Motion: “For every action, there is an equal and opposite reaction”. Neither curve handle can be moved without the other moving in an equal and opposite direction, maintaining the handles at equal length but opposite in direction. Change your anchor point symmetrically to get a feel of what you can do with a symmetric one.

The smooth/tangent is a different sort of an animal. If you use it on a cusp point with two curves, it simply changes it to an asymmetric point. On the other hand, if you use it on a point with lines before and after, it does nothing. But when you use it on a point that has a curve on one side and a line on the other, it gives a smooth transition from a curve to a line by constraining the curve handle to the same direction as the line.

While editing vector images in image editors, you can manipulate the various anchor points and curve handles. Multiple points can be selected to be dragged in unison by either drag-selecting or selecting individual points.

You can adjust the curve handles in a similar fashion by dragging them in or out to shorten or lengthen them, or in a new direction to change the angle of the curve, or both. One end of the curve handle on a given point controls the portion of the segment on that side of the point. The other side of the segment is controlled by the end on the other side of the point.
4.4. Creating and editing vector graphics

There are many tools available for editing vector graphics. We see two of these in this chapter.

- Inkscape
- Corel Draw

4.4.1. Inkscape

Inkscape is a free vector image editing tool available. It is very popular due to the range of features it provides for vector graphics.

Basic Features

There are certain basic features of any vector graphics editor such as positioning. Ways of positioning images include on-screen grid and guide lines where objects “snap” into alignment, dialogs for moving individual objects or for aligning multiple objects, and the create tiled clones dialog for placing multiple clones of an object. Additional features allow you to scale, skew or rotate an object. This section begins with a discussion of the coordinate system of Inkscape, followed by a discussion of the way Inkscape describes object transformations. Then, the commands and dialogs for transforming objects are discussed.

One key aspect to know is that transforming a regular shaped object or a group of objects by the methods described in this chapter does not usually change the underlying description of the objects. For example, suppose you have an ellipse that is 100 pixels wide but you need it to have a width of 50 pixels. There are two different ways to achieve the required width. The first is to scale the object by 50% in the horizontal (x) direction. The underlying definition of the ellipse width remains 100 pixels but when the ellipse is drawn a scale factor of 50% is applied in the horizontal direction. The second way to change the ellipse is to use the ellipse tool to resize the ellipse. In this case, the underlying description of the ellipse changes and no scale factor is applied.
Shapes

Inkscape provides a number of tools for drawing geometric shapes. The tools for drawing regular geometric shapes (rectangles, ellipses, regular polygons, stars, and spirals) are covered here. Path (pencil and pen) tools, discussed in the next section, may be used to draw arbitrary shapes. The style of an object includes attributes that determine how the inside of the shape (fill) and how the boundary path (stroke) are drawn. It also includes shape-specific attributes such as the number of points in a star. New objects are drawn with the current style. The fill and stroke paint colours as well as the stroke thickness of the current style are shown for the shape and path tools at the right end of the tool controls.

The Rectangle Tool Controls showing the current fill colour (blue) and stroke colour (black), as well as the stroke width (1 pixel).

While drawing some objects such as arcs, stars, regular polygons, and spirals, some features such as the orientation of a polygon can be constrained to specific angles with respect to the centre of the shape and the horizontal axis. These angles are multiples of the rotation snap angle. The default snap angle is 15 deg. It can be set under the steps entry in the Inkscape preferences dialog.

Shapes can be scaled, rotated, and skewed. When doing so, a transformation is applied to the shape. The internal parameters defining the shape such as the width and height of an ellipse remain unchanged. This is important to remember if you later modify a shape, for example, by editing the XML file directly.

The star tool includes a randomization feature so that the resulting shapes are not regular. The underlying description is still based on a regular shape.

This is not always true for rectangles. If the option optimised is selected in the store transformation section of the transforms entry of the Inkscape preferences dialog, the x, y, width and
height attributes will change rather than adding a transformation matrix for simple translating and scaling operations.

Paths
Paths are arbitrary shaped objects. Examples of paths are bezier curves and free-hand curves. In this chapter we first see some path terminologies and how paths are described in Inkscape, and then see how paths can be created, and finally how paths are edited.

Paths can be either open (have two ends) or closed (have no ends). They can also be compound (composed of separate open and / or closed paths).

Paths differ from shapes in that there is no predefined structure. For example, a rectangle shape is defined in terms of a width and height with an x and y offset. A corner point cannot be moved independently of at least another corner point. A path, in the shape of a rectangle, consists of the coordinates of the four corner points. A single corner point can be moved by itself with the resulting shape no longer rectangular. A regular shape can be converted into a path.

Filters
Filter effects are a feature of SVG that allow an SVG viewer to change the presentation of an object in a well-defined manner by adding texture to a fill, giving an object a blurred shadow, or modifying the object’s colour. Inkscape supports the Gaussian Blur filter.

Inkscape can be enhanced by effects. These are scripts or programs that can be run from inside Inkscape. Most effects require external programs, usually written in Perl or Python.

4.4.2. Corel Draw
CorelDraw is another great vector image editing tool which is very popular. It not only has the basic features of skewing, flipping and rotating objects, but also a few others as well.
Brightening
Lets you brighten and darken object areas and set the levels of brightness and darkness.

Color add
Lets you simulate a light model by shining three spotlights—red, blue and green on a black background. You can choose the colour and the intensity of the colour you want to add.

Color limit
Lets you view an object area with only black and the lens colour showing through. For example, if you place a green colour limit lens over a bitmap, all colours except green and black are filtered out in the lens area.

Custom color map
Lets you change all the colours of the object area beneath the lens to a colour ranging between the two colours you specify. You can choose the start and end colours of the range and the progression between the two colours. The progression can follow a direct, forward or reverse route through the colour spectrum.

Fish eye
Lets you distort, magnify or shrink the objects beneath the lens, according to the percentage value you specify.

Heat map
Lets you create the effect of an infrared image by mimicking the heat levels of colours in object areas beneath the lens.

Invert
Lets you change the colours beneath the lens to their complementary CMYK colours. Complementary colours are colours that are located on opposite sides on the colour wheel.

Magnify
Lets you magnify an area on an object by an amount that you spec-
ify. The magnify lens overrides the original object’s fill, making the object look transparent.

**Tinted Grayscale**

Lets you change the colours of object areas beneath the lens to their greyscale equivalents. Tinted greyscale lenses are particularly effective for creating sepia-tone effects.

**Transparency**

Lets you make an object look like a piece of tinted film or coloured glass.

**Wireframe**

Lets you display the object area beneath the lens with the outline or fill colour you choose. For example, if you set red for the outline and blue for the fill, all areas beneath the lens appear to have red outlines and blue fills.

This concluded the chapter on vector graphics. There are more tools available than those described here on all platforms including Linux and the Macintosh as well.
What do you do when you’ve transcended the content of this Fast Track and are well on your way to becoming an expert in the field? Go online, of course! We’ve scoured the Web to find you the best places to expand your digital imaging knowledge easily...
5.1 Introduction

Online resources can be classified based on different types of information that they contain. The broad types are:

Knowledge Web sites:
These discuss the basic aspects of digital imaging, design, the intersection of geometry and art, software and hardware, etc. Web sites that carry information about the applications that are the tools of the trade are also clubbed in to this chapter.

Tutorial Web sites
These offer tutorials regarding the use of different applications in the digital imaging arena. Web sites offering downloadable content like Plug-ins that enhance the capability of an application can also be clubbed in to this category. Similarly, Web sites conducting online contests test one's mastery of an application, and also come under this genre of resources.

Showcase Web sites:
These sites enable artists to display their art, and appreciate the work of other fellow artists. Some websites also make it easier for visitors to the gallery who like a piece of art to buy it online.

Networking/Collaboration Web sites:
These are places where digital imaging aficionados can meet and exchange ideas. The numerous forums found online are also filed under different sections really help in this. Incidentally, probably because of the graphical nature of the subject, newsgroups are not a preferred place for discussion. Various newsgroups dedicated to different applications are not as active as the forums mentioned here are.

We shall tackle the Web sites of the first category in this chapter. We will see the remaining categories in the two chapters that follow.
It’s a cliché, but the best site to find any information online is Google.com. Most of the Web sites listed here have been discovered through a direct search on Google. Since it’s not practically possible to cover all the sites thrown up by the search engine, the search terms we employed are mentioned for you—the enthusiastic reader to pick up the trail. Most of the sites mentioned here also have a healthy list of links that connect to other sites that contain information.

In the pages following, we will refer to the activity of employing a computer to create/alter digital images. So Digital Imaging, Computer Graphics, Digital Art, Image Editing, etc. are synonyms.

5.2 Knowledge Web sites

Digital Imaging—whether 2D or 3D, whether involving the modification of an existing image or creating a virtual scene from scratch, whether dealing with the creation of icons to be used in Web pages or creating more serious art work, whether employing the most expensive piece of software or using free alternatives, it all requires knowledge of certain basic principles, besides mastery in the application. The Web sites suggested in this section contain information that answers most basic questions. Search phrases employed by this reviewer are: digital, art, basics, design, imaging, graphics, terminology.

5.2.1 What is Digital Art?
The following Web sites give an idea of the different activities that are presently clubbed under “Digital Art”.

http://design.osu.edu/carlson/history/lessons.html
This site offers a comprehensive and illustrated look at the evolution of the field of Computer Graphics. It tracks the progress of this field from its origins in the first display units for mainframe computers to its present application in various fields like CAD, Animation, Movies etc. Important landmarks in the development
of this industry are described, for example how the term “Computer Graphics” was coined by William Fetter to describe the work he did at Boeing which involved creating graphical human body simulations to study ergonomics. Fetter is also credited with creating the first Computer Graphics TV commercial. The prose and images are supplemented with interesting QuickTime videos of the important events. (The QuickTime plug-in is needed to view such videos). The site is a must read for anyone interested in digital art.
http://www.dfasnm.org/digitalarts.htm
This is the Web site of the Digital Fine Arts Society, New Mexico and offers a brief description of the different forms of activities that come under the "Digital Art" umbrella.
5.2.2 Basic Principles of Digital Imaging

The following Web sites shed light on the jargon and peculiarities of digital media. Terms and concepts like pixels, RGB, resolution, etc are central to understanding digital imagery.

http://dx.sheridan.com/advisor/main.html

This site gives a good grounding of the different aspects of digital imaging. Topics like Image Resolution, Image types and file formats, File compression, Bit depth, Colour Schemes, Vector and Raster graphics, etc are covered here. The concepts are well explained with images.
http://www.tasi.ac.uk/advice/creating/creating.html
This site belongs to an organisation called Technical Advisory Service for Images and takes a thorough look at different aspects of digital imaging. The advice is suitably modified to satisfy the inexperienced user as well as the experts. While there is some overlap with the content in the site mentioned above, the “In-depth reports” available on the site are more detailed with charts, figures and statistics quoted liberally. Some topics discussed in the previous chapter like the article on Image Editing (http://www.tasi.ac.uk/advice/creating/imagenews.html) are more comprehensively covered and are quite useful.

It's like an encyclopedia for image-editing advice!
http://www.designtalkboard.com/glossary/
The site offers a thorough coverage of the different jargon associated with digital imaging and printing. The navigation is a bit quirky with a lot of extraneous text strewn all around. A few clicks and some searching could’ve been avoided with some more organising in the site. The terms are categorised under different headings like design, software, web design, etc. Under each heading, the terms are categorised alphabetically. The terms under each letter are revealed only after clicking on the relevant link. Nonetheless, this initial hiccup is easily overcome. Since the number of terms covered is large, it is much easier to use the search box to quickly pieces of jargon.

Even more jargon-busting...
5.2.3 Basics of Design

While “beauty is in the eyes of the beholder”, some fundamental features are common to most art works that are regarded as good or beautiful. The following sites shed some light on the fundamental design aspects of a good or beautiful piece of art.

http://char.txa.cornell.edu/
This is an interactive textbook titled “Art, Design and Visual Thinking”. It thoroughly discusses the different elements of visual design. The textbook is divided mainly into two sections—

Language of Design and Media of Design, of which only the former is relevant in our case. Over the course of three chapters—Elements of Design, Principles of Design and Creativity and the Design Process, the site offers an incisive look at all the aspects of visual design that are important to any visual artists—digital or otherwise. The pages are loaded with images that aid comprehension, and there are links to other informative sources. The chapters can be accessed from the menu on the left sidebar. The page
uses frames, which can be a problem with some browsers. This site is highly recommended.


This is a starting page for three articles that are worth reading—"The Principles of Design", "The Elements of Design" and "Color: An Investigation". They offer a decent review of the fundamental principles underlying good design. Though the Web site focuses on Web site design, the principles discussed here are universally applicable. Those not keen to wade through the previous Web site can make do with the information in this one.

This is the Web site of the online photo sharing and printing portal—istockphoto. The importance of composition in images is discussed in detail in this article, which is spread over 5 pages. The mathematical basis for some of the rules of composition is revealed here.
5.2.4 Application Options

Photoshop is synonymous with digital imaging. Unfortunately, with a price tag of about Rs 20,000, it is not everyone’s cup of tea. Additionally, being a product targeted at professionals, the chances that a lay user will ever use its vast array of features are remote. There are many applications available at a fraction of the cost—including a toned down version of Photoshop called Photoshop Elements. Besides, there are entirely free options that perform an equal or better job, in most instances. The emphasis in this section is on offering information on the options available. As the links that follow will testify, there are many applications that are active in the digital imaging arena, and each has its own strengths and weaknesses, and associated costs. It is up to you to search for specific reviews of a particular application, and to find if fits the bill. Since it’s not practical to track down and mention image editing software, we have only mentioned the following sites that offer a sufficiently large pool of options for you to start evaluating. While the popular applications like Photoshop and Paint Shop Pro make an appearance in every list, it is the rest of the list that deserves attention.

---

5.2.4 Application Options

Photoshop is synonymous with digital imaging. Unfortunately, with a price tag of about Rs 20,000, it is not everyone’s cup of tea. Additionally, being a product targeted at professionals, the chances that a lay user will ever use its vast array of features are remote. There are many applications available at a fraction of the cost—including a toned down version of Photoshop called Photoshop Elements. Besides, there are entirely free options that perform an equal or better job, in most instances. The emphasis in this section is on offering information on the options available. As the links that follow will testify, there are many applications that are active in the digital imaging arena, and each has its own strengths and weaknesses, and associated costs. It is up to you to search for specific reviews of a particular application, and to find if fits the bill. Since it’s not practical to track down and mention image editing software, we have only mentioned the following sites that offer a sufficiently large pool of options for you to start evaluating. While the popular applications like Photoshop and Paint Shop Pro make an appearance in every list, it is the rest of the list that deserves attention.
Search Phrases employed: graphic, photo, image, digital, editor, 2D, 3D, cg, applications, software

Some sites where digital imaging software options are discussed are mentioned next.

http://www.steves-digicams.com/digsoftwareEditors.html
Since this is primarily a digital cameral review site, the software mentioned on it is mostly related to photography, and is presented as tools to polish a digital image. Nonetheless, the list contains major 2D image editing software and alternatives along with a brief review of its capabilities. Freeware and paid software, both find mention.

http://www.xtort.net/graphics-freeware
This site briefly describes the features of many free graphics software. The applications are categorised into different types like 3D
Graphics, Graphics Editors, Fractal tools, Vector Editors, Digital Imaging tools, etc., which can be accessed from the left sidebar. Roughly about 150 applications are covered under all categories. The list has been created a long time back, with links that go way back to 2002. However, some links to applications are broken. Nonetheless, it offers a bird’s eye view of the available FREE options in this field.

http://graphicssoft.about.com/cs/imageediting/tp/

This is the starting page containing links to four informative articles. The articles are titled “Top 8 Free Photo Editors for Windows”, “Top 5 Beginner Photo Editors for Windows”, “Top 5 Advanced Photo Editors for Windows” and “Top 10 Budget Photo Editors for Windows”. Each of the articles offers a brief review of the application, along with a link with the detailed review (if the application has been reviewed) and a link to the publisher’s Web site or online shop (if the application is not free). A reading of the review of Paint.Net, a free application is recommended.
This page also has links to other resources specifically for imaging applications like Adobe Photoshop, Adobe Illustrator, Corel Paint Shop Pro, Corel Painter, etc. These can be accessed from the left sidebar.

About.com while an excellent source for information has the tendency to break up the content into small chunks and spreading them over too many pages, the obvious motive being to feed more ads to viewers. This is a major annoyance and prevents us from recommending the site often. For more patient readers, we would strongly recommend visiting the many links present on this page that contains information on different aspects of digital imaging.

5.2.5 Application Reviews

A head to head comparison of the features of many digital imaging applications is hard to come by. It is more common to find reviews of single applications. You then have to collate the information spread over several reviews to conclude which application...
is more apt. Also, it is easier to find user reviews of free applications than their paid counterparts, which is quite ironic, since we can all download and install all free alternatives and arrive at a more relevant conclusion.

In this section we shall overlook sites offering reviews of free alternatives, since they are easily available. Almost every site that allows downloading applications offers a review of the application, besides allowing other users to comment. For example, sites like freewarefiles.com, download.com, snapfiles.com, majorgeeks.com, etc have a dedicated section on freeware graphics editors.

Search terms employed: xyz review, compare (replace xyz with the application name)


This site takes 7 digital imaging applications, namely Zoner Photo Studio, Photophilia

Photo Brush, Paint Shop Pro, Photoshop Elements, Ultimate Paint and PFS Photo Tools. These give a comparison of the capabilities of each application across different parameters that are of importance. Some of the parameters considered are resizing, rotating image by small angle, changing image parameters like colour, saturation, etc. Except for the absence of other popular image editors like GIMP, this comparison is really a good reference for anyone looking for an application to accomplish a graphic editing task.


This Web site has a tagline “Reviewing the Reviews”. In fact, this site does the collation part mentioned in the section’s introductory paragraph, easing your burden as the reader. This particular
Web page offers a “meta” review of Paint Shop Pro, Photoshop Elements, PhotoImpact, etc.

Many tutorial sites mentioned in the next chapter also have links to product reviews.

5.3 Conclusion

There is no dearth of online resources on digital art. With the knowledge of the fundamentals of the craft and the choice of tools, what the user needs next is knowledge these tools. We will deal with this in the next chapter.
Now that you’re loaded with knowledge, putting it to good use ought to be easy. While you go through these sites, you’ll find the things you learnt in the previous chapter come up and make sense (more so if they didn’t when you first read them).
6.1 Introduction

In this chapter, you will learn of sites where you can find information on the how-tos for applications in imaging. We hope that the previous chapters have helped you find the applications that suit your needs. Besides, we hope that the websites in this chapter help you in accomplishing those tasks.

Once again, we can comfortably rely on Google for answers. Using search phrases like “xyz” tutorial (replace “xyz” with the digital imaging application of your choice), you can easily find tutorials for any particular application.

Photoshop is the most popular digital imaging tool by far, and an abundance of tutorials on Photoshop corroborates this fact. However, only a few websites specialise on a particular application. Most tutorials are accompanied by screenshots only, but a few websites also offer video tutorials as well. Another feature is the linking mania seen in many sites. Sites which boast of large collection of tutorials in fact do not host the tutorials themselves, but rather only link to the site that has the information. So, it is natural that the same tutorial will be linked to from many sites, thereby increasing the tutorial count of linking sites, but not indicating proportionately increased knowledge.

Let us emphasise here, that this is not an exhaustive list and does not cover all the applications in the digital imaging arena nor does it cover all the sites offering tutorials on digital imaging applications. Also, in addition to the sites mentioned in this chapter, some of the sites you have come across in the other chapters also offer tutorials.

Also note that with screenshots and all the associated graphics involved, the page sizes on these websites tend to be massive, usually a couple of megabytes in size. Video tutorials are in different formats—mostly Flash Video, QuickTime and RealPlayer—so the browser needs to have the requisite codecs to view them. Needless
to say, a broadband connection will reduce waiting times immensely.

6.2 Tutorials


Good Tutorials is a good place for, well, good tutorials

This site has links to over 15,000 tutorials just on Photoshop. Tutorials for other imaging applications, like Adobe Illustrator and Flash are also available. This site sets the mood of the type of sites that are to follow, by simply offering links to the sites having the tutorial. The tutorials are categorised by the application name, the site tracks statistics about the tutorial’s popularity like the number of people who visited the tutorial and the rating given by users like you. The tutorials can be sorted according to date, clicks, rating etc, which makes it easier to find what others are doing. The major drawback of this site is the absence of a search function, which could have otherwise made it easier to get to the desired tutorial. You can overcome this by employing Google’s Advanced Search option, and restrict results to the good-tutorials.com
To do this, visit the Advanced Search link on the Google page, and enter the domain name in the text box that reads “Search within a Site or Domain”. While there is an abundance of Photoshop tutorials, they do not pertain to the same version. Since older tutorials are designed for older versions, they may not be of use to users of a later version.


This site is from a rare genre of single application tutorial sites. It boasts of a tutorial database only on Photoshop that is more than 11,000 tutorials strong! Much like good-tutorials.com, which we have just seen, this site too is merely a listing site with the tutorial actually hosted on a different site. The tutorials are classified into different categories like Special effects, text effects, photo effects, etc. If needed, the entire tutorial list can also be browsed. Tutorials are also rated according to the level of expertise required.
Thankfully there is a search function, which makes it easier to find a particular tutorial. Pslover also allows users to save a tutorial as a favourite, for quick access later. To activate this feature though, a user needs to register. Finding the Register button is an uphill task, and the only place where this seems to make a presence is when the Login link is visited, under the Members section in the left sidebar. The site also allows tutorials to be rated by users, for which registration is not needed. A question and answer feature allows you to post a question which will be answered by other users. This is still in beta phase.

Other benefits of registering are that you can upload your artworks on to the pslover gallery. There already are about 40,000 artworks on display in the gallery. The site sets a size limit of 200KB for the uploaded image. Registered users can also upload their Photoshop files (.psd) for other users to work on and such files are called Renders on the site. Downloading renders does not require registration. Pslover also has a forum where registered users can find and interact with other pslovers. The usefulness of the question and answer feature is questionable, since a forum can be used for similar purposes. One attraction of the forum is the active user challenge sub-forum, where anyone can start or join a contest.

6.2.3. http://www.tutorialized.com/tutorials/
This site offers tutorials on many applications, but the maximum number of tutorials is for Photoshop—over 8,750. The other applications covered include GIMP (97 tutorials), Illustrator (188 tutorials), 3DS Max (815 tutorials) and Maya (222 tutorials). Besides these Graphics applications, you will also find tutorials for other non-graphic applications—Dreamweaver, Java etc. In all, there are over 18,000 tutorials on the site.

The tutorials are classified on the basis of application and under each application the tutorials are further categorised according to their main function—like Drawing, Photo effects etc. This site too, merely links to hosts offering the tutorial. The site lets you rate and rank a tutorial, and tracks the number of users
who viewed it. This helps in finding the popular tutorials can be searched, which is a useful feature. The site also has a forum where you can exchange ideas. You have to register to post on the forum. As a registered user, you can also submit links to tutorials.


This site offers tutorials on Photoshop, Flash, PHP and 3D Studio Max. On the site, one can find over 6,750 Photoshop tutorials mostly as links to other sites, although a small minority is hosted on Pixel2life. There are about 500 tutorials on 3D Studio Max, and about 1,800 tutorials on Flash.

The link to the tutorials is on the top banner. Clicking on the application name link brings up the tutorials in that application. The tutorials are further divided into different categories. The site offers you with a search feature to zero in on the desired tutorial quickly.

The tutorials are listed along with statistical details like the number of users viewing the tutorial, number of users who have
saved it, the rating given to it by users, etc. Compared to other tutorial linking sites, Pixel2life is quite forthcoming about the source of the tutorial, listing the source site name quite prominently in the tutorial’s description.

To be able to post in the Forum, you need to register. Other registration benefits include the ability to rate a tutorial, the ability to create and locally host a tutorial, and the ability to mark a tutorial as favourite for easier retrieval later. To create a tutorial, use Write link on the top bar. A rich text editor is provided for adding the tutorial content.

The forum offers few surprises. For one, it allows users to upload their artwork. Thus, it acts as a gallery, though the navigation is infinitely more difficult compared to a conventional gallery. You can also upload tutorials on the forums. There are sub forums offering tutorials of applications not available on the main page. Downloadable content is also available on the forum.
6.2.5. http://www.cgtutorials.com/

This site offers tutorials on many graphic applications. To name some, Adobe Photoshop.

Autodesk Maya, Autodesk 3DS Max, Blender, Bryce, CorelDraw and Macromedia Flash. Needless to say, Photoshop has the highest number of tutorials at 3,600. Other applications with a sizeable
number of tutorials are 3DS Max with about 1,500 tutorials and Flash and Maya at about 500 tutorials each.

The application menu is to the left. All tutorials for an application are further sub-divided into different headings. As in the case with others, the site merely lists the links that take you to the actual site where the tutorials are hosted. The site has a search feature making it easier to find the desired tutorial. You can rate tutorials and also add comments about it making it easier for other users to decide the relevance of the tutorial before visiting it.

You can rate or add a comment about a tutorial without having to register. You can also add a tutorial to the site’s listing. The site offers rewards for adding tutorials, though what this reward actually is not readily revealed. But, this benefit is available only to registered members. So there is an incentive to be a member of the site. Unfortunately, signing up can be painstaking. A visitor is redirected to another site—3DK.org for registration. After signing up, the same username and password can be used to login at cgtutorials.com. Unfortunately, as far as this reviewer is concerned, the login was unsuccessful at cgtutorials.com for unknown reasons, even as 3DK.org had no similar problems.

6.2.6 http://www.cg-links.com/index.php
This site has about 4,500+ links for tutorials. Various 2D and 3D applications are covered, for example Photoshop, CorelDraw, Illustrator among 2D applications and 3DS Max, Blender and Bryce among 2D applications.

Tutorials on Photoshop are about 1,300. Other applications that are well covered are 3DS Max with about 1,200 tutorials, Maya with around 400 tutorials and Lightwave with around 100 tutorials.

The tutorials are categorised application wise, and tutorials of the same application are further divided based on their func-
TUTORIAL WEBSITES

CG Links takes care of your 2D and 3D needs

Tutorials can be rated by users, and the number of users visiting a tutorial link is also tracked. You can also submit a tutorial to the site.

Besides the tutorials, the site also offers free downloadable content like Textures, 3D models, Photoshop brushes and files. There are also links to Plug-ins for various applications.
This is probably the largest GIMP tutorials site, with about 750+ tutorials. The tutorials are hosted on different sites, and merely linked to gimp-tutorials.com. The tutorials are further classified under different headings like Effects, Designing and Photo Retouching. Users can rate the tutorial, and the number of users who have visited the particular tutorial is mentioned alongside. There is a search box on the site which makes it easier to find the desired tutorial. You can also submit links to tutorials to the site.
6.3 Contest Sites

These are sites which either keeps track of contests being held on other sites or hold contests themselves. The emphasis in this section is on contests that are open to all individuals, have no entry fees, and are conducted online—meaning there is no need to send the prints of the art work physically.

The search phrases used by this reviewer to find these sites with Google search are: graphics, design, contest, competition, “xyz” (replace xyz with preferred application name).

It needs to be noted that forums in sites are places to look for contests. In such forums, users themselves create contests to challenge other users, without the intervention of the site authorities. The details of such contests are available in the forum. It is common to find members of the forum challenging others to improve upon some work that they have already done. Some of the sites already mentioned in this chapter and the preceding and succeeding chapters have forums which hold contests, and hence deserve a mention.

6.3.1 http://www.photoshoptalent.com/

This site holds regular contests for its registered users. The winning three entries get real prizes that can be either items from sponsors or points, which can be converted into cash (at present, payment is effected through PayPal only). As a registered user, you can take part, and upload your work. Other users vote on your work and the one with maximum votes wins. Users who win contests are given a higher ranking in the site, and their votes carry more weight than that of the normal user. The voting system, therefore, is a bit complicated. But the FAQ offers a thorough explanation of how the final votes are tallied.

The site conducts different types of contests: some contests are reserved for those with higher levels (the more the number of contests you win, the higher your level); some contests are for people
Advanced photoshop contests

To participate in these contests, you need a level higher than 1.

- Picture Caption Base
  - Level 1
  - Level 2
  - Level 3
- Storyboard
  - Level 1
  - Level 2
- Lightroom
  - Level 1
  - Level 2

All level photoshop contests

Everyone can participate here, no matter what your skill level.

- Sprite Editor
  - Level 1
  - Level 2
  - Level 3
- Profile View
  - Level 1
  - Level 2
  - Level 3
- Treasured tribute
  - Level 1
  - Level 2
  - Level 3

Beginner photoshop contests

For beginners only. You can only participate if your level is 1 or lower.

- Beach Starter
  - Level 1
  - Level 2
- Fort Decay
  - Level 1
  - Level 2
- Darkapper world
  - Level 1
  - Level 2

In the Spotlight

Build your Photoshop talents with this incredible site
VI TUTORIAL WEBSITES

with more credits (each contest win is worth a few credits, which can also be converted into cash prizes); some contests are open to all users, irrespective of their level and some contests are created by users themselves.

The site offers much more than contests, and the top bar offers links to all the resources on the site. Besides the regular contests, the site also offers tutorials. It has over 250 tutorials self created tutorials (the site rewards users who create tutorials), and about 500 links to tutorials hosted externally. It also has links to 70 video tutorials that are hosted at other video hosting sites like YouTube.com and metacafe.com. Besides tutorials, there are also Guides, which give a blow by blow account of how the contest winning entry was created (the FAQ does elaborate that every contest entry has to be accompanied by a description of the creation process). There is also a gallery containing user submitted images, which you can access from the Art link on the top bar. The gallery is divided into different sections, like Illustration, and Photo Effects, and in all contains nearly 6,000 images. The site also has a Forum. The suggestions link can be used by users to suggest themes for upcoming contests. The Resources link offers links to other sites offering related content—Photoshop tutorials, free downloadable stock photos, free downloadable brushes and textures. The Stock link offers you Royalty free photos contributed by users of the site.

6.3.2 http://photoshopcontest.com/

This site is similar in structure as photoshoptalent.com, which we have just seen. This site also holds regular contests that are open to all registered users. A contest is normally open for three days. Prizes vary from contest to contest, and can include free access to the Premium service of the site for a period of time or some image editing software. Besides the contests, the site has a gallery containing user submitted images. It also offers tutorials which are created in-house, though at the time of this review the tutorials were not updated and were quite old. Besides normal tutorials, there are also video tutorials on the site, which are also quite outdated. The site also has a forum.
Once you register, you can upload files for the contest. The site restricts the images to 125 KB and 800 x 600 pixel size.

6.3.3 http://www.worth1000.com/
This site holds daily contests on different themes—Photoshop, Photography, Text, Multimedia and Jackpot.

The biggest drawback of the site is that it lacks fun. For example, a user is allocated 10 credits on registering, and is precisely the amount of credit that has to be given up to take part in a contest. There is an option to “let other users sponsor the entry”, which reeks of condescension, but doesn’t affect your credit balance.

Besides this major spoiler, the site is a good place to compete across different categories and skill levels. The Jackpot contests are aptly called so, since the cash prizes involved are truly high, usually in hundreds of dollars. Contests are created separately, targeting Advanced users and Beginners. Users can also create a Head-to-
Head contest with fellow users. The other contest types—Photoshop, Photography, Multimedia and Text can be accessed from the top bar. Besides the contests, the site also has galleries containing user submitted works, though it is difficult to offer an estimate of the images contained within. The site also has a forum for users to exchange information. The tutorials link offers about 100 locally hosted tutorials.

6.3.4 http://www.freakingnews.com/
This is a site that holds daily contests involving the manipulation of images, based on some theme that is in many cases related to
present events.

The site is mostly tongue-in-cheek, even though the technique involved in modifying the images requires skill. You can participate in the contest, once you have registered. The winner of a contest gets 100 credits which is equivalent to $5. The payment is made by PayPal only. Contests can have lesser prize money also.

Besides the contests, the site has a tutorial page, which mainly offers information on modifying images, as seen in the contest. There are about 20 tutorials on the site. A gallery containing user submissions for each contest is also available. The site also has a forum.
6.4 Downloadable Resource Websites

Major applications like Photoshop and GIMP allow the integration of plug-ins or add-ons to enhance their capability. The following sites offer such resources or links to such resources. Google Search Phrases used: add-on, plug-in, download, graphics, "xyz" (replace xyz with application name)


This site is an excellent starting point to find downloadable resources on the Net. Nicely categorised, and well laid-out links with a brief description make the page quite user friendly. Most of the links on this site connect to free content. The links are categorised by the application. Plug-ins for applications like Photoshop, Illustrator, Paint Shop Pro, and Painter are present. Photoshop-compatible plug-ins can also be used in other applications like Corel Photopaint and Paint Shop Pro etc. These plugins are grouped separately. The site also offers its own free plug-ins,
which are also accessible from a link on the page. The other plug-ins are hosted externally and linked on this page.

Besides plug-ins, the site also offers links to sites offering free textures and brushes.


This page has a huge list of links connecting to plug-ins. A brief description of the site and the plug-ins on offer also accompanies the link. Most of the links on this page are for paid software. For free options, the link is available lower down the page. The free options can also be accessed from this page:

6.4.3. http://registry.gimp.org/list_content
This page lists all the plug-in options for GIMP available on the GIMP.org site.

6.5 Conclusion
As a student, you can find all the necessary resources to master the application online for any imaging application. Forums and Contests are a great way to exchange ideas with other enthusiasts.
Satisfied with your imaging skills? Think you have what it takes to impress the masses (or even just your friends)? There’s only one thing to do, then—go public! Several sites offer you the space to showcase your art, so take the opportunity while you can.
7.1 Introduction

This chapter sheds light on Web sites that allow you to display your artwork. These websites serve two purposes. First, as a budding artist, you get an opportunity to display your work which can be viewed and critiqued or commented by viewers. Second, it allows you to view the works of others to gain inspiration or learn the finer aspects of the art. This chapter is targeted at both audiences.

There are many websites that allow registered users to showcase their artwork on the site for free. Some also charge for the privilege. In either case, all Web sites allow casual visitors to view the works of artists who have put up their work for display. Some websites also act as an online art shop, allowing users to order prints of the digital works that they display.

Since it is normal for any artist to put up his work on more than one gallery, especially if the service is free, the same art work will crop up in multiple galleries.

The more populous galleries are mentioned next.

7.2 The Galleries

Deviantart.com is an online art gallery that has been around for close to 8 years. It has a massive collection of art works spread across many categories. The site claims to have about 52 million deviations (a term used by the site to refer to pieces of art) on display among its pages. Obviously, the members of the site are called Deviants.

Digital Art is just one category of artworks on the site where a user will obviously find digital images. Digital art is also visible in many other categories, as well. For example, under the anthro section, the digital media category has many digitally created human
The design & interfaces section also has many categories which have digitally created art works. The manga and anime section has digitally created characters. The fan art category also contains a section on digital art.

Registration on the site is free. You are given a deviantart.com sub-domain, like xyz.deviantart.com where xyz is the username. You can then upload deviations to create a gallery. After the upload, you are given the opportunity to set the print account, from where you can buy the hard copy of the digital image. The standard print account is freely available with the free membership. The premium print account allows greater control over printing and its sale. For example, the standard print account does not allow you to set the selling price of the print, while you can do so in the Premium account. Once the deviation is uploaded, it is available for everyone to view and buy.

The site also offers a deviantArt+ membership which rids off all the ads on the Web pages, and also allows more images to be displayed per page. You can also browse through the older archives of the site, which they claim has 52 million images including the archived images which you cannot view with the free account.

Besides the gallery, registered users also get a journal or blog with which can jot down thoughts.

The site has an active and strong forum for deviants to interact with each other. The discussions are categorised into many sub-forums. The site also has a Resources section that contains a lot of free content for the use of digital imaging enthusiasts. There are tutorials on different digital imaging applications, downloadable content to enhance digital imaging applications and other downloadable content like textures, Fonts, 3D models, fractals, vectors and stock photos. The tutorial section on digital art is categorised into different digital imaging procedures like Airbrushing, Photo manipulation, Vector Art, 3D Art, and Fractal Art. Tutorials on each activity are further divided according to the application.
DeviantArt is easily one of the most popular sites to showcase your stuff.

Tutorials on all the major applications like Photoshop, Paint Shop Pro, Painter and GIMP are available.

The Resources section on this site also offers downloadable content like Brushes, Actions, Add-ons, and Plug-ins for various...
applications like Illustrator, GIMP and Photoshop. The other resources available for download are 3D models that can be imported into 3D applications like 3DS Max.

The lack of a description makes the process of choosing any of the above mentioned resource a difficult one. Fortunately, the textures and fonts are self descriptive, and so you should face no problems in choosing either of these resources.

What takes the sheen off this otherwise excellent site is the difficult navigation menu which acts as a bottleneck. Getting from one section of the mammoth site to another requires a lot of scrolling and clicking, which could have been avoided by employing less flashy, but more functional, text links.

7.2.2. cgsociety.org

The tone of this Web site is that of a professional, no-nonsense one. The content and coverage of events seem to indicate that the site is targeting the highest echelons of CG artists—those who apply
their skills to create visual effects in movies and computer games. The site, in that sense, offers digital art enthusiasts a glimpse of the best that the field has to offer.

This is a huge Web site, that has it all—tutorials, forum, galleries, job listing, news section, etc. Let us start with the Portfolio section, which has around 110,000 images and can be accessed from the Portfolio link on the top menu bar. The images on display here are excellent examples of the true potential of digital imaging, which is expected for reasons mentioned later. Each artist maintains a portfolio and accessing any image from the artist takes one to his portfolio, which besides displaying the images, also shows a brief bio-data.

To browse through the images in the Portfolio section of the site, use the Browse link. There is also a search facility that can be employed to find images containing certain keywords. Since each image is accompanied by the names of the applications used to create it, searching for the application name produces a list of images created with it.

To add to the confusion, besides the portfolio section, there is also a gallery section which is sub-set of the images on the portfolio the place where the artwork of the free members are on display. There are about 20,000 images in the gallery. The images that are in the gallery are reviewed by the in-house editors, and are of greater quality. The images in the gallery are categorised into 2D or 3D, and the layout is similar to that seen in forums, except that every topic has a thumbnail of the image in that post. The gallery entries are further put to vote, and the best of them are selected for the CG Choice Awards and are available in the CG Choice Awards Gallery. The links to the various galleries are available in the top menu bar.

There are two types of memberships offered by the site. The free membership, also known as the CG Talk membership, allows the user to interact in the forum and have a portfolio of up to five
images, besides some other minor limitations. The paid membership offers you unlimited access to the site and its features, is free from ads and grants preferential treatment on some services.

The site, as already mentioned, has a professional touch to it and resembles any job hunting site. Here, you are asked to fill in your profile while loading images to the portfolio, with a reminder that “CGPortfolio is a key resource for potential employers and clients so make sure your information is correct, up to date and professionally presented”. In fact, the employment angle perhaps contributes to the self censoring among users, making them put up only their best work in the portfolio. The site sets some limits to the images that can be uploaded, with the minimum size being 600x600, and the maximum being 1600x1600 pixels, and a file size of up to 500Kb.

You can also access and update the details of your profile on the portfolio page. Here, you can also create a blog, which is available for all members. You can use other employment-friendly measures like creating job searches to automatically shortlist job offers.

Besides the portfolio, there is a forum for enthusiasts to interact with each other. There are contests held in the forum, many of which are created by other users themselves, which are put under the “Mini Challenges” sub-forum. The site also holds contests which are discussed in the “CG Challenges” sub-forum. The work-in-progress and critique sub-forum is a place where you can upload your incomplete works and seek the opinion of other users. The general techniques and application specific sub-forum offers tips and tricks on different aspects of digital art, similar to a tutorial.

The site also offers a Job search function for its users. Users can reply to job offers right from within the site. There is a job search button just below the top menu bar to the right.

The details of the CG Challenge contests are available from the Events link on the top menu bar. The site claims that these chal-
The challenges are the “largest online art contests of their kind”. If you consider the number of sponsors, their claim surely has substance. The instructions and terms and conditions as well as prizes for the contest are available on the same page.

7.2.3. http://www gfxartist.com/

Following in the footsteps on cgsociety.org, gfxartist.com is another site that offers the same basket of services—gallery, forum, tutorials, job listings, etc. The high point of the site is, without doubt, the collection of 55,000+ works of art in the gallery.

The Web site is filled with articles and interviews on the computer graphics arena. The links to the gallery are not immediately visible, but are present under the community tab in the top menu bar. The member gallery links takes you to the gallery containing images that have been uploaded by other users. The elite galleries showcase the work of the elite members of the site. Elite members
are those users who are highly rated. The GSpot gallery contains artworks that have received the highest points/votes.

The galleries are arranged under different categories like 3D modelling, Drawing, Painting, Photo Manipulation, Photography and Design. You can visit the images of each category by clicking on the Enter the gallery link. To browse all images on the site, without classification, use the browse all new artwork link at towards the bottom of the page, after the new artwork gallery. Registered users can vote for an image which improves its position among the ranks of images, and granting its creator the Elite status.

You can register on the site for free, and it offers the freedom to create a gallery. The site does not allow free members to upload actual images to the site, but only allows linking to the image, which has been hosted elsewhere. You can upload thumbnail images. The GFXArtist Plus account does not have this limitation.

Besides the Gallery, the site also has a forum where artists can interact, which can also be accessed under the Community Tab. There are sub-forums that offer job listing, Competitions between users, tips and tricks, etc.

The features tab has some other resources of the site. There are
links titled Tutorials, Interviews, Articles, etc, which guides you to
the respective resources. The content in these links are antiquated,
and probably only the content in the tutorials withstand the test of time. Some links in the tutorials section connect to external sites.

7.2.4. http://digitalart.org/
This site is notable only for its 20,000+ strong art work gallery. The start page allows easy access to the images, which are broadly classified into categories like Abstract/Surreal, Cartoon/Illustrations, Photo Manipulations, etc. Clicking on any of the categories will show the images classified under it. The layout is quite simple, without any distractions or needless menus. The site offers a search feature which can be used to find a particular art work. Images in each category also can be filtered on different parameters to narrow the number of displayed images.

Registration is free, though a paid registration offers some additional benefits like the ability to turn off ads. Registered users
can upload their artwork to the site. A size limit of 225 KB and maximum dimension of 1300x1600 pixels is applicable. Submissions are reviewed before they are put up on the site.

The site offers links to other resources as well, which can be accessed from the features link on the top bar menu. There are links to Interviews, Articles, Jobs and Projects etc., but the content on most of these links is out-dated. Only the job offers mentioned in the Jobs and Projects link are current.

7.2.5. http://www.3dlinks.com/

This aptly titled site is a treasure trove of well organised links connecting to other sites. The only resource that is locally hosted is the gallery, which has about 20,000 images in it. The images are accessible from the gallery link on the left side bar. The images are categorised in different ways, based on the Artist name, application used, theme, etc. Under each of these main categories, the images are further classified. Clicking on any of the links brings
up a page with 20 images. Navigating through the galleries is easy, thanks to the efficient site layout. Visitors can rate an artwork and offer comments.

The site also allows you, as a registered user to upload your artwork for display on the site. To register, visit the contact us link on the left sidebar. A 500 KB file size limit is applicable.

The gallery forms just one section of the Web site. The sidebar allows easy access to the other sections like the Forum, Tutorials, News, Downloadable resources, etc. The discussion forum link takes the user to the forums. The menu options list the sub-forums available. The Tutorial link presents a sub-menu of applications which have a tutorial. There is an abundance of links to tutorials on most of the applications listed. In general, all options in the menu lead to pages that are well stocked with links to other sites.

One small nag on the site is the nesting menu that is the only way to navigate through the site. It can be difficult to use if there are too many levels of menus nested.

This site is similar in feel and features as cgsociety.org. The gallery boasts of over 13,000 art works. The images are classified into different categories based on their content—like Architecture, Animals, Cartoons, Sci-fi, Sculpture, etc. Strangely, even though every image on the site was created digitally, a “Graphics/Digital Art” category is also listed.

The images can be browsed by category, or by Artist name, or by the any other order like the Date of Publishing. All the links are clearly laid out in the start page itself, making the viewing a pleasure.

Viewers are constantly reminded about the facility to add their own artwork to the site by flashing “Submit Image” gallery, which is a tad irritating. Registration is necessary before an image can be
submitted. And the size sets a size limit of 150 KB for the uploaded image. If the flashing “Submit Image” revealed unprofessional, the two failed attempts at uploading files confirmed it. But, probably it was a temporary phenomenon.

Besides the gallery, the site also has a forum. Here, there are sub-forums where you can post your artwork and seek views of other users. A sub-forum to ask for help on different applications is also present. A Jobs link on the top menu bar brings the job services page on the Web site. Here, a registered user can create a resume and apply for jobs.

7.2.7 http://artworks.avalonweb.net/gallery/gallery_main.php
This plain looking Web site allows just about anyone to place a link to their artwork hosted elsewhere. The artwork is reviewed before it is made available on the site which explains the absence of unrelated images on the site. There are no categories, or other indications on the depth of the site or the number of links on the site to be found anywhere. Even the date of the creation of a link is not mentioned.
Each page has 20 links to images, where you can only progress one page at a time in either direction. Add to that the black page colour and absence of the usual flashiness common in such sites, browsing this site is an almost eerie experience.

So, navigation and ambience are not the strong points of the site (even though there is a search box that allows searching the site on Artist name). But, this understated Web site offers about 15,000 links to user submitted art works. The best way to randomly view a page is to directly modify the URL. For example the URL for page no 2 is [http://artworks.avalonweb.net/gallery/gallery_main.php?pagenum=2&]. Making suitable changes in the URL it is possible to visit page 100, 700, etc. It needs to be mentioned that most of the links that appear in the later pages are dead. So an accurate figure of the number of active links on the site is anyone’s guess.
7.2.8 http://www.galleryof3d.com/

This site offers about 6,500 pieces of 3D art. It is a simple site with an efficient navigation system that is designed to allow unrestricted art appreciation. This is a pure gallery site without any forum, or tutorials or other extraneous features. It is administered by a single individual who also filters all submissions, which becomes quite evident when you receive the activation email after registering on the site.

The images on the site can be accessed with the Galleries button on the top menu bar. This will produce a list of artists who have uploaded their images on to the site. The left sidebar menu offers other options of viewing images—like Top 100 images, Chronological Order, Software used, etc. The images can be rated and commented by any viewer, without having to register. Each image is accompanied by relevant information about it, like the application used, the dimensions, the file size, etc.

The site allows registered users to upload their artwork to be displayed. A size limit of 4 MB is applicable. The image is not
immediately available for viewing and has to pass through the site admin before it goes online.

The site also has a Links section where links to different resources, including other galleries are available.

7.3 Conclusion

The emphasis in this chapter was those sites that did not charge a user fee to display their artwork. There are other galleries that have a strong art work base, but were not included because they charge users to display their art. Also, we have limited ourselves to describing those websites that have the largest collection of artwork. There are many good websites that have not made the cut for this reason, as well.

What this chapter has shown is that there is no dearth of galleries which freely allow a digital art enthusiast to display his/her work and gain recognition.